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IMPORTANT NOTICE
DISCLAIMER OF WARRANTY

Epson America makes no representations or warranties, either express or 
implied, by or with respect to anything in this manual, and shall not be liable for 
any implied warranties of merchantability and fitness for a particular purpose or 
for any indirect, special, or consequential damages. Some states do not allow the 
exclusion of incidental or consequential damages, so this exclusion may not 
apply to you.

COPYRIGHT NOTICE
All rights reserved. No part of this publication may be reproduced, stored in a 
retrieval system, or transmitted, in any form or by any means, electronic, 
mechanical, photocopying, recording, or otherwise, without the prior written 
permission of Epson America, Inc. No patent liability is assumed with respect to 
the use of information contained herein. Nor is any liability assumed for 
damages resulting from the use of the information contained herein. Further, 
this publication and features described herein are subject to change without 
notice.

TRADEMARKS
EPSON and EPSON Stylus are registered trademarks of SEIKO EPSON 
CORPORATION.

PhotoPC is a registered trademark and EPSON FaxAdvice, EPSON Photo!3, 
HyPict, PhotoEnhance, and Image Authentication System are trademarks of 
Epson America, Inc. 

EPSON SoundAdvice is a service mark of Epson America, Inc. 

Image Expert and Camio are trademarks of Sierra Imaging, Inc. in the United 
States and other countries and are used under license.

Lexar Media is a trademark of Lexar Media.

General notice: Other product names used herein are for identification purposes 
only and may be trademarks of their respective owners. EPSON disclaims any 
and all rights in those marks.

A NOTE CONCERNING RESPONSIBLE USE OF 
COPYRIGHTED MATERIALS

Digital cameras and scanners, like photocopiers and conventional cameras, can 
be misused by improper copying of copyrighted material. While some countries’ 
laws permit limited copying in certain circumstances, those circumstances may 
not be as broad as some people assume. EPSON encourages each user to be 
responsible and respectful of the copyright laws when using digital cameras and 
scanners.

Copyright © 1999 by Epson America, Inc. CPD 8478
Torrance, California, USA 7/99
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our new EPSON PhotoPC 800 is a high resolution,Ytwo megapixel, USB and serial digital camera small 

enough to fit in your pocket, purse, or briefcase. It includes 

three different user modes with three levels of control: fully 

automatic point-and-shoot for the beginner photographer, 

and increasing levels of control for intermediate and expert 

photographers.

The PhotoPC 800 comes with a built-in microphone that 

lets you add voice messages to your photos, and an LCD 

screen so you can view your pictures before and after you 

capture them. You can display your images on a TV or 

multimedia projector, or transfer them to your computer. 

You can even upload pictures, text, and graphics into your 

camera, and play them back for presentations. 

Introduction
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The PhotoPC 800 captures images at 1600 × 1200 pixel 

resolution in 24-bit color, using a 2.14 megapixel CCD 

sensor. With EPSON’s HyPict™ image enhancement 

technology, the images can be interpolated to 1984 × 1488 

pixels right inside the camera. 

Your PhotoPC 800 comes complete with cables, batteries, 

battery charger, soft camera case, handstrap, and 8MB 

CompactFlash™ memory card. It also comes with a 

CD-ROM with software and utilities for downloading, 

editing, organizing, and printing your pictures. 

PhotoPC 800 Features

PhotoPC 800 is a complete system for capturing digital 

images, and includes the following features:

◗ 2.14 million pixel CCD sensor

◗ Resolutions of 1600 × 1200 pixels, and up to 

1984 × 1488 pixels (interpolated) using EPSON’s 

HyPict image enhancement technology

◗ 24-bit color or grayscale image capture

◗ High-speed image processing (one second per image in 

quick shot mode)

◗ 8MB EPSON CompactFlash card that holds 

approximately 24 fine-resolution or 120 standard-

resolution images

◗ Built-in microphone that lets you record a voice message 

of up to 10 seconds for each picture

◗ 1.8-inch, active matrix TFT color LCD screen that 

supports instant preview, playback, delete, and power 

save mode

◗ Capability to print directly to several EPSON ink jet 

printers—without using a computer

◗ Video output for playing your pictures back on a TV, 

VCR, or projector

◗ Macro, 2× digital zoom, panorama, quick shot mode, and 

interval and continuous shooting
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◗ Adjustments for white balance, exposure, sensitivity, 

aperture, shutter, and focus

◗ Built-in flash with a slow synchronized mode for night 

photography

◗ Four rechargeable NiMH AA batteries and a fast charger

◗ Automatic shut-off to save batteries

◗ Automatic date and time recording for each picture

◗ Serial and USB cables for transferring photos to your 

Windows or Macintosh computer

◗ Fully USB-compatible

Your camera comes with the PhotoPC 800 software suite, 

which includes the following applications for both PC and 

Macintosh users:

◗ Sierra Imaging Image Expert™ software for transferring, 

organizing, editing, and printing your pictures

◗ The EPSON Photo!3™ application and TWAIN driver 

for transferring your pictures

◗ EPSON Photo File Uploader for converting 

presentation slides into image files and uploading them 

to your camera

◗ EPSON Photo Program Uploader for installing the 

Direct Print program on your camera (Direct Print lets 

you print directly from the camera to a number of 

EPSON ink jet printers)
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Optional Accessories

EPSON offers these accessories for the PhotoPC 800:

◗ Universal AC adapter (B867062) for use with any 

standard (100 to 240 V) electrical outlet 

◗ Additional or replacement NiMH rechargeable batteries 

(B818061)

◗ Additional or replacement universal NiMH Power Pak, 

which includes batteries and charger (B818172)

◗ EPSON Image Authentication System™ (IAS) software 

(PPC8–IAS)

You can also obtain additional CompactFlash memory cards 

and PCMCIA adapters from leading suppliers, such as Lexar 

Media™ and SanDisk. 

Minimum System Requirements

To transfer images to your computer and edit them, make 

sure your system meets these minimum requirements:

Windows Systems 

◗ IBM-compatible PC with 486 or higher processor

◗ Microsoft Windows 98, Windows 95, or 

Windows NT 4.0 (Service Pack 3 or later 

recommended)

◗ Serial port with standard RS-232C interface (19200 bps 

or higher), or USB support for Windows 98 computer 

with built-in USB port.

◗ At least 32MB RAM 

◗ Double-speed CD-ROM drive

◗ At least 40MB free hard disk space

◗ VGA or SVGA monitor with at least 256-color display

◗ Mouse or other pointing device

◗ 16-bit sound card and speakers (for voice annotation 

feature only)
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Macintosh Systems 

◗ One of the following systems:

Macintosh PowerPC™ with System Software Version 

7.5 or later

Power Macintosh® G3 with System Software Version 

8.51 or later

iMac™ computer with System Software Version 8.1 with 

iMac Update 1.0

◗ At least 32MB RAM

◗ At least 30MB free hard disk space

◗ CD-ROM drive

◗ VGA monitor with minimum resolution of 640 × 480

◗ Macintosh modem/printer serial port (19200 bps, or 

higher) or built-in USB port on an iMac or new 

Power Mac G3

◗ 16-bit sound card and speakers (for voice annotation 

feature only)

NOTE

If your iMac is running OS 8.1, you must download and install the 

iMac Update 1.0 from Apple at http://swupdates.info.apple.com 

before you install the PhotoPC 800 software. Contact Apple 

Computer if you have problems installing this update or if you 

have any questions. If your iMac is running OS 8.5, you do not 

need to download and install the iMac Update 1.0. Your operating 

system already includes full support for the PhotoPC 800 

software. (To find out which operating system your iMac is 

running, select About This Computer in the Apple menu.)
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Where To Get Help

EPSON provides technical assistance through electronic 
support services and automated telephone services 
24 hours a day. 

The following tables list the contact information:

To speak to a technical support representative, dial 

(310) 974-1983 (U.S.), or (905) 709-3839 (Canada), 

6 AM to 6 PM, Pacific Time, Monday through Friday. 

Toll or long distance charges may apply.

Before you call, please have the following information ready:

◗ Product name

◗ Product serial number

◗ Computer configuration

◗ Description of the problem

Electronic support services

Service Access

World Wide Web From the Internet, you can reach EPSON’s Home 
Page at http://www.epson.com.

EPSON Internet FTP Site If you have Internet FTP capability, use your Web 
browser (or other software for FTP downloading) 
to log onto ftp.epson.com with the user name 
anonymous and your e-mail address as the 
password.

EPSON Forum on 
CompuServe® 

Members of CompuServe can type GO EPSON at 
the menu prompt to reach the Epson America 
Forum. For a free introductory CompuServe 
membership, call (800) 848-8199 and ask for 
representative #529.

Automated telephone services

Service Access

EPSON SoundAdvice For pre-recorded answers to commonly asked 
questions about EPSON products 24 hours a day, 
seven days a week, call (800) 922-8911.

SM

EPSON FaxAdvice™ Access EPSON’s technical information library by 
calling (800) 922-8911. You must provide a return 
fax number to use this service.

EPSON Referral Service For the location of your nearest Authorized 
EPSON Reseller call (800) 922-8911.

Automated telephone services

Service Access
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You can purchase manuals and accessories from EPSON 

Accessories at (800) 873-7766 (U.S. sales only). In Canada, 

please call (800) 873-7766 for dealer referral. Or visit our 

website at www.epsonsupplies.com (U.S. sales only).

Software Support

If you are having problems with a software application 

included with the camera, you can call one of the following 

numbers for technical support:

◗ (800) 501-8902 for Sierra Imaging Image Expert 

software questions. Available weekdays 9 AM to 5 PM, 

Pacific Time. Or e-mail support@sierraimaging.com. 

Worldwide support number is (831) 461-4710.

◗ (310) 974-1983 for the EPSON Photo!3 application 

and TWAIN driver, the EPSON Photo File Uploader, 

the EPSON Photo!3 Program Uploader, and the Direct 

Print software.

Software Licensing

You can install EPSON Photo!3, the EPSON Photo File 

Uploader, and the EPSON Photo!3 Program Uploader on 

multiple computer systems. If you want to install Image 

Expert on multiple computer systems, please contact Sierra 

Imaging at (800) 501-8902 regarding the licensing fee.

Registration

Please take a minute to fill out the registration card for the 

PhotoPC 800 digital camera and mail it back to us. This 

enables you to receive special information on accessories, 

new products, and software upgrades. You’ll get immediate 

attention if you have a problem with your PhotoPC 800.
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Safety Instructions

Read all of these instructions before using your camera and 

battery charger. Also follow all warnings and instructions 

marked on the camera, battery charger, and batteries.

◗ To reduce the risk of electric shock, do not remove the 

camera’s cover or open any of the compartments except 

as instructed in this User’s Guide.

◗ To prevent fire or electric shock, do not insert objects 

through any openings in the camera or battery charger. 

Do not expose the camera or battery charger to rain or 

moisture.

◗ To prevent fire or explosion, do not use the camera or 

battery charger where inflammable or volatile gas is 

stored.

◗ If the camera shows unusual signs such as noise, odor, or 

smoke, turn it off immediately. Remove the batteries 

and/or disconnect the AC adapter, and unplug the AC 

adapter from the electrical outlet.

◗ If the battery charger shows unusual signs such as noise, 

odor, or smoke, unplug it immediately.

◗ To avoid damage to the optics of the camera, do not 

expose the lens to direct sunlight for extended periods of 

time.

◗ Do not use the charger near water. Never insert or 

remove the charger’s power plug with wet hands.

◗ Keep the charger away from heat sources. Do not use 

outside the temperature range of 32 to 95 °F 

(0 to 35 °C).

◗ Do not use the charger within reach of children.

◗ Do not insert batteries backwards.

◗ Use only the types of power sources listed on the charger 

label and in this User’s Guide. Always supply power to 

the charger directly from a standard domestic electrical 

outlet.

◗ Do not charge the batteries using an electrical outlet on 

an airplane.
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◗ Do not use the camera outdoors during adverse weather 

conditions.

◗ Do not store the camera near sources of bright light, 

direct sunlight, high humidity, heat, excessive dirt or 

dust, or where it will be exposed to strong vibrations or 

magnetic fields.

◗ To prevent possible eye injury, do not take flash pictures 

of faces at close range.

◗ Avoid sudden temperature changes, which can cause 

moisture to condense on the camera. Keep the camera in 

a case or bag if you need to move it from a cold 

environment to a warm one. Allow time for the camera 

and its optional accessories to adjust to temperature 

changes before using them.

◗ Do not use a frayed or damaged power cord with the 

AC adapter.

◗ Remove batteries and/or unplug the camera and the AC 

adapter and refer servicing to qualified service personnel 

under the following conditions: if the power cord or 

plug is damaged; if liquid has entered the camera; if the 

camera has been dropped or its exterior has been 

damaged; if the camera or its optional accessories do not 

operate normally or exhibit a distinct change in 

performance.

◗ Adjust only those controls that are covered by the 

operating instructions.

◗ Do not attempt to service the camera or battery charger 

yourself. Refer all servicing to qualified service 

personnel.

◗ If the liquid crystal solution contained in the display 

panel or in the LCD screen leaks out and gets on your 

hands, wash them thoroughly with soap and water. If it 

gets in your eyes, flush them immediately with water.
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14.

efore you can start using your PhotoPC 800, you Bneed to charge the batteries. You should also be familiar 

with all the camera components. 

This chapter describes the following:

◗ Unpacking your PhotoPC 800

◗ Identifying camera parts

◗ Using rechargeable NiMH batteries

◗ Attaching the wrist strap

◗ Using the CompactFlash memory card

◗ Setting the date and time

◗ Installing your PhotoPC 800 software

1   

Unpacking Your PhotoPC 800

Make sure you have all the parts shown below. 

software

Mac/Direct Print 
serial cable

rechargeable 
batteries

wrist strap

camera

PC serial cable

battery charger

CompactFlash 
card (8MB)

video cable

camera bag

AC power cord USB cable

Getting Started
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Identifying Camera Parts

flash

viewfinder

timer light

front view

lens AC adapter 
connector

lens cover switch
interface 
connector

video out 
connector

shutter buttoncamera dial

bottom view

battery 
cover lock

memory 
card covertripod 

socket

battery 
cover

memory 
card cover 
lock
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status display panel
viewfinder 
and photo 
capture light

LCD 
screen

back view

MENU 
button

hand strap 
holder

 + button
microphone

− button

ISO 
button W.B. 

button

camera status light

top button 
(unlabeled)

bottom 
button 
(unlabeled)

top view

camera dial

dial lock

shutter buttonimage quality button

flash button

self timer button
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Using Rechargeable NiMH Batteries

Your PhotoPC 800 comes with a charger and four 

rechargeable NiMH batteries that can be recharged hundreds 

of times. While you use two batteries in your camera, you 

can keep a replacement set of batteries charged and ready to 

take along.

NOTE

New batteries need to be fully charged three times before you 

use them. This process takes approximately five or six hours—

but you only need to do it once. When you need to recharge your 

batteries in the future, it takes approximately two and a half hours 

for a full charge.

Charging Batteries

It’s important to fully charge your batteries, so they will last 

as long as possible before they need recharging. 

WARNING

Shock hazard. Make sure you use the charger only with EPSON 

rechargeable NiMH batteries (model EU-24). To avoid the danger 

of leakage or explosion, do not place any other batteries in the 

charger. Read all safety and handling instructions in the 

Introduction of this guide before using the charger.

Follow these steps to charge your batteries for the first time:

1 Insert two or four batteries, positioning the + and – ends 

as shown. 
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2 Connect the battery charger to the battery charger power 

cord, as shown below. 

3 Plug the charger into an electrical outlet. The charger 

light turns red, indicating that the charger is working. 

When the batteries are charged, after about two and a 

half hours, the light goes off. 

NOTE

The charger light flashes to indicate changes in battery 

temperature and voltage. If the light continues to flash for 

more than half an hour, the batteries may be damaged or 

worn out, and should be replaced. Unplug the charger if the 

batteries are not fully charged after four hours.

4 Now charge your batteries again by unplugging the 

battery power cord and then plugging it in again. 

5 Charge the batteries a third time. After the charger light 

goes off, unplug the charger. To avoid overcharging, 

don’t leave the charger plugged in for long periods of 

time after the light goes off.

6 Wait one hour until the batteries cool before removing 

them from the charger.

7 Before storing the charger, disconnect the power cord 

and remove the batteries.

(For subsequent charges of your NiMH rechargeable 

batteries, follow steps 1 through 3, then unplug the charger 

and follow steps 6 and 7 above.)

Be sure to charge the batteries completely to make them last 

as long as possible. They can be recharged hundreds of times, 

so do not dispose of them until they are worn out.

charger light
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NOTE

To keep the charger terminals clean, unplug the charger and wipe 

the terminals with a dry cloth. Make sure you charge the batteries 

before you use them. If you find that your batteries run out faster 

after you recharge them a few times, make sure you discharge 

them completely before recharging. If this doesn’t help, replace 

the batteries.

Installing Batteries

Before you install the batteries, make sure the camera is 

turned off.

1 Turn the camera upside down. 

2 Hold the battery cover lock down and slide the cover 

out to open it.

 

battery cover lock
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3 Insert two batteries into the compartment, positioning 

the + and − ends as shown below.

4 Lower the battery cover and slide it in, as shown below.

When the battery power is almost out, a low battery icon 

appears on the camera’s display panel. Be sure to 

replace both batteries at the same time. 
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Battery Options

If you forget to charge your rechargeable NiMH batteries or 

if they need to be replaced, the PhotoPC 800 camera can also 

accept the following:

◗ Rechargeable AA NiCad batteries

◗ Single-use AA lithium batteries (longer life, Energizer 

recommended)

WARNING

To avoid the danger of fire or explosion, do not mix different 

types of batteries. Do not allow the battery contacts to touch 

metal objects such as coins or keys, which could short out the 

battery’s circuits. Read all safety and handling instructions before 

using batteries.

Note the following when handling batteries:

◗ Use only the EPSON battery charger (Model EU-38) to 

charge the batteries that came with your camera.

◗ Use the batteries that came with your camera only in 

EPSON digital cameras.

◗ Do not use manganese batteries.

◗ Do not mix different types of batteries; this can cause 

fire or explosion.

◗ Replace both batteries at the same time. Do not mix old 

and new batteries.

◗ Batteries that have not been used for a long time do not 

charge well. However, with regular use, the batteries will 

return to normal.

◗ Batteries discharge at least 2% per day, whether they are 

used or not.

◗ If the batteries are charged in a hot environment, or if 

they are charged repeatedly without being discharged, 

they will wear out more quickly.

◗ Do not drop, puncture, disassemble, or mutilate 

batteries. Do not get them wet or expose them to fire.

◗ When the camera is not used for long periods of time, 

remove the batteries and store them at a low temperature 

in a dry location. Store away from the reach of children.
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◗ To avoid fire or electric shock, do not use batteries that 

are leaking or damaged in any way.

◗ If battery acid gets in your eyes or on your skin, 

immediately rinse the area with water and seek medical 

treatment. If a battery is swallowed, seek medical 

treatment immediately.

◗ Dispose of used batteries according to the 

manufacturer’s instructions and in compliance with all 

applicable laws. Contact your local government agency 

for information about battery recycling and disposal.

◗ Battery life varies depending on the battery type, the 

manufacturer, and other factors.

Attaching the Wrist Strap

To attach the wrist strap, follow these steps:

1 Push the loop on the end of the strap through the small 

opening in the holder on the side of the camera. (You 

may need to use a small pointed object, such as the tip of 

an untwisted paper clip, to push it through.)

2 Pull the strap through the loop and tighten, as shown 

below.
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Installing Your Memory Card

Your camera comes with an 8MB CompactFlash memory 

card that you need to install before you take any photos. 

Since there is no internal camera memory for storage, this 

card will store your photographs until you transfer them to 

your computer.

You can purchase additional memory cards (4MB to 96MB) 

from leading suppliers like Lexar Media and SanDisk. See 

page A-2 for more information.

1 Make sure the camera dial is turned to Off and the lens 

cover is closed. (To change the dial setting, press the 

white dial lock in and turn the dial.)

2 Turn the camera upside down and open the memory 

card cover by sliding the memory card cover lock in the 

direction of the arrow, as shown below.

dial lock

memory card 
cover lock
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3 Insert the card all the way into the memory card slot. 

Make sure the front of the card is facing the front of the 

camera, and the arrow on the card’s label is pointing 

down.

4 Close the memory card cover.

Next, you need to set the camera’s date and time in 

preparation for formatting the memory card.

Setting the Date and Time

Before you use the camera, you need to set its clock. Then 

the camera will automatically record the date and time for 

each picture you take. You may need to set the clock again if 

you don’t use it for extended periods of time.

NOTE

You can also set the camera’s clock through your computer. See 

page 6-1 for instructions on connecting the camera to your 

computer, and page 10-5 for instructions on setting the date and 

time.

front of camera

top button

+ button

− button

bottom button

W.B. button

MENU button

camera dial lock

camera dial 
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Follow these steps to set the date and time:

1 Push the camera dial lock in and turn the camera dial 

to . 

2 You see the clock setting screen with the month 

highlighted in red.

3 Press the + or − button (next to the up and down 

arrows) to increase or decrease the number, until the 

month is correct.

4 Press the W.B. button (below the right arrow) to move 

through the day and year, and make adjustments as 

described in the previous step.

5 When you’re finished, press the MENU button (under 

BACK). You see the SETUP menu.

6 Turn the camera dial Off.

Now you’re ready to format the memory card.

Formatting Your Memory Card

You should format your card before you use it. Follow these 

steps:

1 Turn the camera dial to . Then press the W.B. button 

(below Memory SETUP). The Memory Card Format 

menu appears if a memory card is installed in the 

camera.
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2 Press the top button (next to MEMORY CARD 

FORMAT) to format the card. You see a message 

warning you that all data on the card will be deleted if 

you format it.

3 Press the button next to Yes to format the card, or the 

button next to No to cancel.

Removing Your Memory Card

Turn your camera dial to Off before you remove the card.

CAUTION

Never remove the card while the camera is on. Data in the card 

may be lost or damaged.

1 Open the memory card cover.

2 Press the eject button next to the memory card and 

remove the card by hand. Then close the cover.

eject button
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Installing Your PhotoPC 800 

Software

PhotoPC 800 comes with everything you need to transfer 

your pictures from the camera to your computer, organize, 

enhance, and share your images, and insert them into 

documents. You can also upload pictures and presentations 

to your camera. The PhotoPC 800 CD-ROM has these 

applications for your Windows or Macintosh computer:

◗ Sierra Imaging Image Expert

◗ EPSON Photo!3 TWAIN and standalone application, 

and EPSON Photo!3 Program Uploader

◗ EPSON Photo File Uploader

Follow the steps in the appropriate section below to install 

the software on your computer.

Installing for Windows 98, Windows 95, or 

Windows NT 4.0

Follow these steps:

1 Insert the CD-ROM in your drive. The Setup program 

starts automatically.

If it doesn’t start automatically, double-click My 

Computer. Then double-click your CD-ROM icon.

2 On the first screen, select the language you want to use.

3 When you see the following screen, click the Install 

Image Expert button.
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4 Follow the instructions on the screen to install Image 

Expert. When installation is complete, you return to the 

Setup screen. 

5 Click the button labeled Install EPSON Photo!3 and 

Program Uploader and follow the instructions on the 

screen. 

6 When you return to the Setup screen, click the Install 

EPSON Photo File Uploader button. Follow the 

instructions on the screen.

7 When installation is complete, click Exit.

Your camera software is now installed. 

Installing Your Windows 98 USB Driver

If you’re installing on a Windows 98 system with a USB 

port, complete the steps above to install your software. The 

first time you connect the camera to your computer with 

your USB cable, you’ll see the Add New Hardware Wizard. 

Click Cancel. (See page 6-2 if you need help connecting the 

camera.)

NOTE

You may need your Windows 98 system disk to perform this 

installation.

Follow these steps to install the driver for your camera:

1 Insert your PhotoPC 800 CD-ROM in your CD-ROM 

drive, if necessary.

2 At the first screen, click Next.

3 Select Search for the best driver for your device, 

then click Next.

4 Select Specify a location and browse to your 

CD-ROM drive.

5 Select the Win98E folder if you’re installing the English 

driver (or the Win98S folder to install the Spanish 

driver, or the Win98F folder to install the French 

driver). Click OK.

Altair.book  Page 15  Thursday, July 1, 1999  3:33 PM



1-16   Getting Started

6 On the following screen, click Next. The wizard locates 

your camera’s driver.

7 Click Next on the installation screen to install the 

driver. When installation is complete, click Finish.

Your camera software is now installed. 

Installing on a Macintosh

Follow these steps:

1 Insert the CD-ROM in your drive.

2 If necessary, double-click the CD-ROM icon to open it.

3 Open the folder for the language you want to use.

4 Double-click the Install Image Expert icon. Click 

Continue and follow the instructions on the screen.

5 When you’re done installing Image Expert, click 

Restart to restart your computer.

6 Open the folder for your language, then open the 

EPSON Photo!3 Ver. 1 folder.

7 Double-click the Photo!3 Installer – Part 1 icon. 

Click Continue and follow the instructions on the 

screen. When installation is complete, click Restart to 

restart your computer.

8 Open the folder for your language. Then copy the 

EPSON Photo File Uploader folder to the EPSON 

Photo!3 Ver. 1 folder on your hard drive.

NOTE

To create the preferences for the EPSON Photo File 

Uploader, start, then close the EPSON Photo!3 program 

on your hard drive. You need these preferences to run Photo 

File Uploader.

Your camera software is now installed. 
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 aking pictures with the PhotoPC 800 is similar to Tusing a traditional “point and shoot” auto focus 

camera. This chapter gives you all the basic information you 

need to start taking pictures, including the following:

◗ Using the camera dial

◗ Reading the status display panel

◗ Taking pictures with the viewfinder

◗ Taking pictures with the LCD screen

2   

Using the Camera Dial

The camera dial has an 

Off position and six other 

settings: three for taking 

pictures, and three for 

performing other functions, 

such as setting up your 

photos or playing them 

back on the LCD screen. 

When Off is selected, press the white dial lock in to turn the 

dial. (You don’t need to press the dial lock in when another 

setting is selected.)

dial lock

Taking Pictures
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Camera dial settings include the following:

Use this setting for continuous and interval 

shooting. See pages 4-10 through 4-13 for details.

Use this setting to take photos with the LCD screen. 

See Chapter 4 for information about how to change 

settings in the View menus.

Use this setting to take photos with the optical 

viewfinder. See page 2-4 for details.

Use this setting to play back, delete, and add voice 

recording to your photos. See Chapter 5 for details.

Use this setting to print directly from your camera to 

an EPSON ink jet printer. See Chapter 12.

Use this setting to set up or view information about 

your camera on the Setup screen. See Chapter 4 for 

information.

Reading the Status Display Panel

When your camera dial is turned to , , or , the status 

display panel shows the camera’s current settings and how 

many additional pictures you can take. 

.

Checking the Battery

When your battery power is almost out, the low 

battery icon appears on the display panel. The icon 

flashes when your battery power is completely out. 

pictures 
remaining

low 
battery 
icon

exposure

white 
balance

sensitivity

image quality

monochrome 
indicator

timer

flash
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You need to recharge or replace the batteries or use the 

optional universal AC adapter when you see the low battery 

icon. Although you may be able to use the camera with low 

batteries, it needs full battery power to operate reliably.

Several factors can affect battery life, including the 

surrounding temperature and the type of batteries you use. 

Low temperatures—especially below 50 °F (10 °C)—drain 

batteries faster. See page 1-4 for battery use instructions.

Checking the Picture Counter

The large number in the lower right of the status display 

panel shows how many additional pictures you can take.

This number is affected by the image quality setting. Also, 

if you have any voice recordings stored on your memory 

card, the number on the display panel may be greater than 

the actual number of remaining pictures.

When the memory card is full, the number on the display 

panel reads 0, the status light on the back of the camera 

flashes red, and you can no longer use the shutter button. 

Before you can take any more pictures, you need to delete 

some of the images on the memory card. (See page 5-4 for 

instructions.) 

If you want to save your photos before you delete them, 

connect the camera to your computer and transfer the 

pictures as described in Chapter 6.

Instead of the number of pictures remaining, you may see 

one of the following in the lower right corner of the status 

display panel:

In quick shot mode, the number of photos 

taken is displayed in brackets.

In Program or Manual mode, the exposure 

value appears on the left and the shutter 

speed appears on the right when you hold the 

shutter button down halfway. See page 4-2 

for more information about user modes.
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When you turn the camera’s dial to , SEt 

is displayed. No other information appears 

in the status display panel.

When you make a voice recording, rEc 

appears in this space.

When you take photos using the interval 

shooting feature, Int appears in the display 

panel.

Taking Pictures With the Viewfinder

You can capture an image as you would with any 

point-and-shoot auto-focus camera: look through the optical 

viewfinder and press the two-step shutter. 

NOTE

One advantage of the optical viewfinder is that it uses less 

battery power than taking pictures with the LCD screen. 

However, you can’t use the optical viewfinder when you make 

voice recordings or use the panorama or digital zoom features. 

viewfinder

photo capture light

camera status light

camera dial
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Follow these steps:

1 Make sure you are at least 20 inches (50 cm) away from 

your subject. (If you want to get closer, use macro mode 

as described on page 4-7.)

2 Slide the lens cover switch to open the lens cover. Then 

turn the camera dial to  and wait until the status light 

turns green.

3 Look straight through the viewfinder and center your 

subject within the cross-hairs.

NOTE

The frame in the viewfinder indicates the area captured 

when taking pictures at close range.

4 Use the camera’s controls to make any changes you want 

to image quality, the flash, or other basic settings. (See 

Chapter 3 for information about changing settings when 

taking pictures with the viewfinder.)

5 Hold the shutter button halfway down to lock the auto 

focus. 

shutter buttonviewfinder

photo capture 
status light

camera status light
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While holding down the shutter button, you can 

reframe your picture and move your subject off-center if 

you want. The photo capture status light stops flashing 

when the lens locks in focus.

6 Press the shutter button the rest of the way down to take 

the picture.

7 Hold the camera still until it beeps, then release the 

shutter button.

NOTE

You may notice a brief delay between the time you press the 

shutter button and when the camera beeps. To avoid blurring 

your images, make sure you hold the camera still until it beeps.

After you take a picture, the photo capture status light 

flashes. This indicates that the image was captured and the 

camera is processing it. When the light stops flashing, the 

image is saved.

CAUTION

If you set the camera down while the light is still flashing, make 

sure you handle it carefully. The camera may lose your image if 

you set it down too hard. 

Saved images remain on the memory card even when you 

turn the camera off or remove the memory card or the 

batteries.

Taking Pictures With the LCD Screen

The LCD screen lets you see a live preview of what the 

camera’s lens sees at any moment. Although you can use this 

setting anytime, you always choose it when you want to use 

the panorama or digital zoom features, or when you want to 

make voice recordings to go with your photos. 
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NOTE

Before you begin to take pictures, you can use the LCD menus to 

turn recording on and make many other adjustments to your 

camera. See Chapter 4 for details.

Follow these steps:

1 Make sure you are at least 20 inches (50 cm) away from 

your subject. (If you want to get closer, use macro mode 

as described on page 4-7.)

2 Slide the lens cover switch to open the lens cover. Then 

turn the camera dial to  to see the View menu. Wait 

until the camera status light turns green.

You see a preview of your picture on the LCD screen, 

with the image quality setting in the upper left corner of 

the screen and the digital zoom setting in the upper 

right. 

The following screen illustrates what you see if your 

camera is set to Full Auto user mode, the default user 

mode. The settings may look different if you’re using 

Program or Manual user mode. See Chapter 4 for details 

about user mode.

image 
quality digital zoom

Normal
Macro
Panorama

Altair.book  Page 7  Thursday, July 1, 1999  3:33 PM



2-8   Taking Pictures

NOTE

If you’re using batteries, the camera shuts off automatically 

after a designated period of inactivity. (The default is 10 

seconds. See page 4-26 for instructions on setting the 

power off interval.) If the image on your LCD screen 

disappears, press the shutter button to “wake” the camera.

3 Using the preview image to guide you, make any final 

changes to the settings on the View menu. See 

Chapter 4 for details.

NOTE

You can also use the camera’s buttons to change the image 

quality, flash, or timer. See Chapter 3.

4 Center your subject on the screen, then press the shutter 

button halfway down to lock the auto focus.

The camera status light stops flashing and you see a 

green circle  on the screen when the lens locks in 

focus. While you hold the shutter button down, you can 

reframe your picture if you want.

5 Press the shutter button the rest of the way down to take 

the picture.

camera status light

microphone

press to 
delete
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6 Hold the camera still until it beeps. Then release the 

shutter button. (You may notice a brief delay between 

the time you press the shutter button and when the 

camera beeps. To avoid blurring your images, make sure 

you hold the camera still until it beeps.)

After a few seconds, you see a confirmation screen.

NOTE

You can press the button next to Delete if you don’t want 

the picture. You can also delete pictures in playback mode. 

(See Chapter 5 for details.) 

When the camera status light stops flashing, you’re ready 

to take another picture. Or, if you’ve turned recording 

on, you see a countdown of the recording time on the 

screen. During this time, you can record a message into 

the built-in microphone on the back of the camera. (See 

page 4-13 for more information on recording a 

message.)

NOTE

◗ The LCD screen uses up battery power quickly. If it’s idle for 

more than the designated power off interval, the camera 

turns off automatically. To turn it back on, press the shutter 

button, or turn the camera dial to Off and then back to . 

See page 4-26 for instructions on changing the power off 

interval.

◗ Even if you don’t speak into the microphone, your camera 

records ambient noise when recording is turned on, and your 

images take up more space on the memory card. To fit more 

images on your memory card, make sure you turn recording 

off when you no longer want to use it.

Altair.book  Page 9  Thursday, July 1, 1999  3:33 PM



2-10   Taking Pictures

Altair.book  Page 10  Thursday, July 1, 1999  3:33 PM



Using the Camera Buttons to Change Settings   3-1

A

B

3

 

ou use the camera’s buttons to set the flash, enable Ythe timer, and set image quality. You can also make 

quick adjustments to other basic settings, which gives you 

greater control of your images when you’re taking pictures 

with the viewfinder. This chapter explains the following:

◗ Setting image quality

◗ Using the flash

◗ Taking pictures with the timer

◗ Adjusting the sensitivity setting

◗ Adjusting the white balance setting

◗ Adjusting the exposure setting

3   

Setting Image Quality

The PhotoPC 800 has four image quality (resolution) 

settings. Press the image quality button on top of the camera 

to cycle from one setting to the other.

NOTE

The camera dial must be turned to , , or .

image quality 
button

Using the Camera Buttons to Change 

Settings
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The image quality icons appear on the status display panel as 

described below.

Standard

Produces color or black and white images at 640 × 480 

pixels. The CompactFlash card holds approximately 

118 standard image quality pictures without audio 

recordings, but the image size is smaller and includes less 

detail when enlarged. This setting is good for pictures that 

are viewed on screen or on the Web.

Fine

Produces color or black and white images at 

1600 × 1200 pixels, with moderate compression. Your 

pictures include ample detail, and the CompactFlash card 

holds approximately 25 pictures without audio recordings.

Super Fine

Produces color or black and white images at 

1600 × 1200 pixels with low compression. Your pictures 

include greater detail, and the CompactFlash card holds 

approximately 12 pictures. With less compression, super fine 

images are better for enlarging.

HyPict

Produces color or black and white images at 

1984 × 1488 pixels (interpolated) with moderate 

compression. Your pictures include excellent detail, and the 

CompactFlash card holds approximately 10 HyPict pictures. 

These images are best for enlarging for 8 × 10-inch prints.
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Using the Flash

The camera’s built-in flash is effective within a range of 1.6 

to 11.2 feet (0.5 to 3.4 m), or 6 inches to 1.6 feet (15 to 

50 cm) when using the macro feature. Press the flash button 

to cycle through the four flash settings. 

NOTE

The camera dial must be turned to , , or .

An icon for each setting appears on the status display panel, 

as shown below:

Auto

The flash goes off automatically whenever it’s needed 

for adequate lighting (factory setting).

Forced Flash

The flash goes off with every picture you take. Use this 

setting to compensate for backlighting; for example, 

when you are facing a light source.

Flash Off

The flash is disabled, even when adequate lighting is 

not available. Use this setting for special effects, 

where flash photography is prohibited, or for macro mode 

close-ups.

Slow Synchronized Flash

To light up the background as well as your subject, 

use the slow synchronized flash mode when taking 

pictures at night. This option causes the aperture to stay 

open longer, allowing more light to enter the camera.

NOTE

Slow synchronized flash is available only in the Program or 

Manual user modes. See page 4-2 for information about changing 

the user mode.

After you take a flash picture, the icon blinks until the flash is 

fully recharged. Your flash setting remains in effect even after 

you turn off the camera.
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TIPS

◗ When you’re using the flash off setting, hold the camera 

steady or use a tripod to avoid capturing blurry images.

◗ When you’re taking pictures outdoors, make sure the sun is 

at your back. In very bright light (at the beach or in snow, for 

example), your pictures may come out too light. You can 

adjust the exposure manually to darken an image before you 

capture it. See page 4-22 for instructions. Alternatively, you 

can use Image Expert or other image editing software to 

correct over-exposure problems after you take the picture. 

See Chapter 9 for details about editing photos.

Taking Pictures With the Timer

Setting the timer creates a 10-second delay between 

the time you press the shutter button and the actual 

image capture. This allows you to take a picture of yourself. 

You can also combine continuous shooting with the timer 

for delayed automatic capture of ten images in ten seconds. 

This allows you to photograph yourself in motion. (See page 

4-11 for more information.)

Follow these steps to take a single picture with the timer:

1 Secure the camera on a flat surface or on a tripod. (See 

page A-4 for information on attaching the camera to a 

tripod.)

2 Open the lens cover.

3 Turn the camera’s dial to . Then wait until the photo 

capture status light turns green.

4 Press the timer button  on the top of the camera. The 

timer icon appears in the status display panel.

timer button
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5 Press the shutter button. The timer icon and the red 

timer light on the front of the camera flash slowly for 

eight seconds. Then they flash rapidly for two seconds 

before the shutter is released.

The camera beeps when the image is captured. The 

status light on the back of the camera flashes green as the 

PhotoPC 800 processes the image(s). 

NOTE

To cancel a picture after you’ve pressed the shutter button, 

press the shutter button again, or press the  button.

Making Advanced Adjustments

You can also use the camera’s buttons to adjust the 

sensitivity, white balance, and exposure settings. However, 

you must be in Program or Manual mode to make these 

adjustments. See page 4-2 for instructions on changing the 

user mode.

NOTE

◗ You can also use the LCD screens to adjust sensitivity, white 

balance, and exposure. See Chapter 4 for details.

◗ The camera dial must be turned to , , or  to change 

settings using the camera buttons.

Adjusting the Sensitivity Setting

The camera’s high sensitivity settings let you take pictures in 

low light or indoors without the flash. With these settings, 

you can set the sensitivity from the camera’s standard ISO 

equivalent of 100 to an ISO equivalent of 200 or 400. 

You can also use the high and super high sensitivity settings 

when taking pictures of fast-moving subjects, or when 

shooting distant subjects with a flash. Since image quality is 

lower when you use higher sensitivity settings, the standard 

setting is recommended for most photos.
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Press the ISO button on the back of the camera to cycle 

through the three sensitivity settings. 

The arrow icons in the upper left corner of the status display 

panel indicate the sensitivity setting:

The standard setting is equivalent to ISO 100. This 

is the recommended setting for most photos.

The high sensitivity setting is equivalent to ISO 

200.

The super high sensitivity setting is equivalent to 

ISO 400.

Adjusting the White Balance Setting

Normally the PhotoPC 800 adjusts the white balance of your 

pictures automatically. This means that both outdoor and 

indoor pictures have accurate colors, without a “bluish” or 

“yellowish” appearance.

However, you can have the camera use a fixed white balance 

for a warmer appearance under fluorescent lighting or for 

special effects, such as a red-tinted sunset. You can also 

customize the white balance setting.

Press the W.B. button on the back of the camera to cycle 

through the three white balance settings.

ISO button

W.B. button
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The setting, which appears in the status display panel next to 

the W.B. mark, remains in effect while you take pictures.

The PhotoPC 800 includes the following white balance 

settings:

AUTO Adjusts the white balance of your photos 

automatically. This is the recommended setting 

for most pictures.

FIX Locks the white balance setting at 5200 °K. 

(This setting is similar to normal daylight.)

CUST Lets you define a custom white balance setting. 

See page 4-21 for more information about 

photographing with a user-defined white 

balance.

Adjusting the Exposure Setting

Your camera normally adjusts exposure automatically. 

However, if you want to lighten or darken a photo before 

you take it, you can adjust the exposure manually.

Press the + or − button on the back of the camera to increase 

or decrease the exposure setting. (The range for this setting is 

−2.0 to +2.0.)

white 
balance 
setting

+ and − buttons
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The setting appears in the status display panel next to 

the +/− mark and remains in effect while you take pictures.

exposure setting
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Jim Jackson’s Auto Sales

• 1995 Mitsubishi Montero

• Good condition

• Low Mileage

FOR SALEFOR SALE

999-555-5555

he LCD menus let you preview your pictures while Tyou make your camera settings. This chapter explains 

the following:

◗ Choosing the user mode

◗ Taking color or black and white pictures

◗ Taking quick shots

◗ Taking digital zoom pictures

◗ Taking close-ups with macro mode

◗ Taking digital panoramic pictures

◗ Using continuous and interval shooting

◗ Adding voice recordings to pictures

◗ Using programmed subject settings

◗ Adjusting the sensitivity setting

Using the LCD Menus to Change 

Settings
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◗ Adjusting the white balance setting

◗ Adjusting exposure

◗ Adjusting the focus manually

◗ Changing the metering method

◗ Setting camera options (automatic power off, LCD 

brightness, alert beep, language, and time and date)

NOTE

If you’re using batteries, the camera shuts off automatically after 

a designated period of inactivity. If the image on your LCD screen 

disappears and your camera dial is set to , press any button on 

the back of the camera to “wake” the camera. If your dial is set 

to  or , press the shutter button to wake the camera.

Choosing the User Mode

The PhotoPC 800 has three user modes to fit the needs of 

beginner, intermediate, and expert photographers. Each 

mode gives you a different amount of control over the 

camera settings, whether you’re using the LCD screen or the 

viewfinder to take pictures. To use the more advanced 

features, such as white balance and exposure adjustment, you 

must be in Program or Manual mode.
MENU

+

–

ISO W.B.

top button

bottom button
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Full Auto The camera chooses settings for you. This mode, 

which is the default, is recommended for the 

beginning photographer. You can simply point 

and shoot, or you can still adjust some basic 

settings if you want (for example, image quality, 

digital zoom, and macro or panoramic mode).

Program This setting is recommended for the 

intermediate photographer who wants a 

moderate amount of control over the camera’s 

functions. Programmed subject settings 

(Normal, Sports, Portrait, and Landscape) tailor 

your camera settings to the type of picture you’re 

taking. You can also use the LCD menus to 

make your own adjustments to sensitivity, white 

balance, and exposure.

Manual This setting is for experienced photographers 

who want complete control over the camera’s 

wide array of settings and features. In addition to 

changing sensitivity and white balance, you can 

adjust the shutter speed and aperture, choose a 

spot or divided brightness metering system, and 

focus the camera to three feet, eight feet, or 

infinity.

Follow these steps to choose the camera mode:

1 Push the camera dial lock in and turn the dial to . 

You see the SETUP menu.

2 Press the + button to cycle through the three modes.

user mode
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Taking Color or Black and White 

Pictures

You also use the SETUP menu to switch between color and 

black and white pictures. 

NOTE

There is no difference between the file sizes of color and black 

and white pictures when you take pictures with the LCD screen.

Follow these steps:

1 Turn the camera dial to . You see the SETUP menu.

2 Press the − button to change the setting.

Taking Quick Shots

After taking a picture, the PhotoPC 800 normally takes a few 

seconds to process and save the image in the installed 

memory card. In quick shot mode, the camera stores up to 

10 images internally in temporary storage while you keep 

taking pictures. It saves the images to the CompactFlash card 

after you’re done.

Follow these steps to use quick shot mode:

1 Turn the camera dial to . You see the SETUP menu. 

(Normal Shot appears in the bottom right corner of 

the screen.)

color/
monochrome 
setting
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2 Press the bottom button (next to Normal Shot) to 

select Quick Shot. 

3 Slide the lens cover switch to open the lens cover.

4 Turn the camera dial to  or  and wait until the 

camera status light turns green. The image quality icon 

 on the status display panel flashes, indicating that 

quick shot mode is enabled.

5 Press and hold the shutter button to begin taking 

pictures. When you’re finished, release the button.

The bracketed number on the status display panel 

indicates the number of pictures temporarily saved to 

the camera.

NOTE

◗ You can’t use quick shot mode when battery power or 

CompactFlash card memory is low.

◗ HyPict image quality is disabled in quick shot mode.

◗ When using quick shot mode, you can only make an audio 

recording for the last image.

Taking Digital Zoom Pictures

Digital zoom pictures are magnified two times (2×). This 

format is like a digital version of telephoto. The automatic 

cropping effect makes file sizes smaller, allowing you to store 

more pictures in the digital zoom format.
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This setting is available for all user modes (Full Auto, 

Program, and Manual).

1 Open the lens cover and turn the camera dial to .

You see the View menu. The current digital zoom 

setting appears in the upper right corner.

NOTE

This View menu illustrates what you see if your user mode is 

set to Full Auto. Your View menu will look different if the 

user mode is set to Program or Manual.

2 Press the top button (next to the ×1).

The words DIGITAL ZOOM appear on your LCD 

briefly. A yellow frame appears around the previewed 

image, and the digital zoom setting changes to ×2.

3 Press the shutter button halfway to lock the auto focus.

When the lens locks in focus, the camera status light 

stops flashing and you see a green circle  on the 

screen. If you want, you can reframe your picture while 

you hold the button down.

4 Press the button all the way down to capture the image.

The zoom format remains active until you change it or turn 

off the camera.

NOTE

Since the digital zoom mode crops the image and magnifies it, it’s 

best to print the image in a smaller format.

digital zoom
setting
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Taking Close-Ups With Macro Mode

You can use the camera’s macro mode to take pictures as 

close as 6 inches (15 cm). This setting is available for all user 

modes (Full Auto, Program, and Manual).

Follow these steps:

1 Open the lens cover and turn the camera dial to . You 

see the View menu.

NOTE

This View menu illustrates what you see if your user mode is 

set to Full Auto. Your View menu will look different if the 

user mode is set to Program or Manual.

2 Press the bottom button (next to the current frame 

setting). 

For a few seconds, the word MACRO appears on the 

LCD screen, and a green frame appears around the 

previewed image. Also, the macro mode icon  appears 

in the lower right corner of the screen.

3 Press the shutter button halfway to lock the auto focus.

When the lens locks in focus, the camera status light 

stops flashing and you see a green circle  on the 

screen. If you want, you can reframe your picture while 

you hold the button down.

4 Press the button all the way down to capture the image.

Macro mode remains active until you change it or turn off 

the camera.

frame setting
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NOTE

When you take macro close-ups, you should use a tripod (as 

described in Appendix A) and disable the flash. Otherwise, your 

pictures may appear blurry and washed out.

Taking Digital Panoramic Pictures

Images in the panoramic format are long and narrow, 

although they are not captured at a wider angle than normal 

images. Strips at the top and bottom of the image area are 

cropped out. Smaller file sizes mean you can store more 

pictures in the panorama format.

NOTE

You can’t select standard  image quality when taking 

panoramic pictures. For more information about image quality, 

see page 3-1.

You can take panoramic pictures using any user mode (Full 

Auto, Program, or Manual). Follow these steps:

1 Open the lens cover and turn the camera dial to .

You see the View menu. The current frame setting 

appears in the lower right corner.

NOTE

This View menu illustrates what you see if your user mode is 

set to Full Auto. Your View menu will look different if the 

user mode is set to Program or Manual.

frame setting
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2 Press the bottom button (next to the current setting) to 

cycle through the frame settings (Normal Frame, 

Macro, and Panorama). 

For a few seconds, the word PANORAMA appears on 

the LCD screen, and a black frame appears around the 

previewed image. Also, the panorama mode icon  

appears in the lower right corner of the screen.

3 Press the shutter button halfway to lock the auto focus.

When the lens locks in focus, the camera status light 

stops flashing and you see a green circle  on the 

screen. If you want, you can reframe your picture while 

you hold the button down.

4 Press the button all the way down to capture the image.

The Panorama format remains active until you change it or 

turn off the camera.

The following examples show the same subject captured in 

normal, digital zoom, and digital panorama formats:

normal digital zoom

digital panorama
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Continuous Shooting

In this mode, you can take two standard or fine 

resolution pictures each second, with up to ten pictures in 

sequence (or one super fine resolution picture per second, 

with up to eight pictures in sequence). You can capture a 

complex motion, such as a golf swing, in a series of steps to 

create animation sequences for the Internet, screen savers, or 

presentations. Continuous shooting is available for all user 

modes.

NOTE

You can’t use the flash for continuous shooting, so make sure 

you have adequate lighting for your pictures. In addition, you can’t 

select the HyPict image quality setting.

1 Make sure you are at least 20 inches (50 cm) away from 

your subject. 

2 Open the lens cover, then turn the camera dial to . 

Wait until the camera status light turns green. 

You see a preview of your picture on the LCD screen, 

with a red frame around it. CONTINUOUS appears on 

the screen.

3 Center your subject in the red frame. 

4 Press and hold the shutter button all the way down. The 

camera beeps as it captures each picture. 

5 When the camera has captured the first sequence of 

pictures, it stops beeping and the camera status light 

flashes. Release the shutter button.

NOTE

If you continue to hold down the shutter button after the first 

sequence of pictures, the camera will take a second sequence. 

The camera will continue to take pictures until the memory card 

is full.
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Continuous Shooting Using the Timer

You can also combine continuous shooting with the timer 

for delayed automatic capture of a series of images. This 

allows you to photograph yourself in motion.

NOTE

You can capture 10 standard or fine resolution images or 8 super 

fine resolution images in eight seconds.

1 Secure the camera on a flat surface or on a tripod. (See 

page A-4 for information on attaching the camera to a 

tripod.)

2 Open the lens cover, then turn the camera dial to . 

Wait until the camera status light turns green. 

You see a preview of your picture on the LCD screen, 

with a red frame around it. CONTINUOUS appears on 

the screen.

3 Center your subject in the red frame. 

4 Press the timer button.

The timer icon  appears on the status display panel to 

indicate that the timer is enabled.

5 Press the shutter button.

You have 10 seconds to get ready for “action” in front of 

the camera.

The timer icon and the red timer light on the front of 

the camera flash slowly for eight seconds. Then they 

flash rapidly for two seconds before the shutter is 

released.

timer button
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The camera beeps each time it captures an image, and 

the timer light on the front of the camera flashes as the 

images are processed.

Interval Shooting

You can use this time lapse feature to capture scenes that 

change over time, such as a sunset or a busy street corner. 

Your camera lets you set a time interval from 10 seconds to 

24 hours. Interval shooting is available for all user modes.

NOTE

When you’re adding audio recordings or taking pictures with 

HyPict image quality, the shortest time interval available is 20 

seconds.

Follow these steps to use the time lapse feature:

1 Secure the camera on a flat surface or on a tripod. (See 

page A-4 for information on attaching the camera to a 

tripod.)

2 Open the lens cover, then turn the camera dial to . 

Wait until the camera status light turns green.

You see a preview of your picture on the LCD screen, 

with a red frame around it. CONTINUOUS appears on 

the screen.

3 Hold down the MENU button (under PRESS or 

HOLD) until you see the following screen:

The current setting for the time lapse interval (hours, 

minutes, and seconds) appears in the center of the 

screen, with seconds highlighted.

time lapse 
interval setting
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4 Press the + or − button (next to the up and down 

arrows) to change the highlighted setting, then press the 

ISO button (under the left arrow) to move to the next 

setting and repeat the process. Continue until you’ve set 

the correct interval.

NOTE

You can also choose the maximum interval (24 hours) by 

pressing the top button (next to Max Interval), or the 

minimum interval (10 seconds) by pressing the bottom 

button (next to Min Interval).

5 Press the shutter button to take the first picture.

The camera turns off automatically after you take the 

first picture, then turns on again after the selected 

interval to take the next photo.

6 To stop taking pictures, turn the camera’s dial to Off.

Adding Voice Recordings to Pictures

Your camera has a built-in microphone that lets you add a 

voice recording of up to 10 seconds to each photo. You can 

make a recording immediately after shooting a photo, or add 

it later. (For information about adding a recording later, see 

page 5-8.) You can make voice recordings in any user mode.

NOTE

You can’t record a message when taking a picture with the 

optical viewfinder or when taking a picture in Quick Shot mode.

microphone

Altair.book  Page 13  Thursday, July 1, 1999  3:33 PM



4-14   Using the LCD Menus to Change Settings

Follow these steps to add a recording right after taking a 

picture:

1 Turn the camera dial to  to display the SETUP menu. 

2 Press the MENU button (under Camera SETUP). You 

see the Camera SETUP menu. The current audio setting 

appears at the bottom of the screen under Rec.

3 Press the ISO button (under Rec) to choose a different 

setting. You can record a 3, 5, or 10-second message, or 

turn recording off.

4 Open the lens cover and turn the camera dial to . 

Center the subject on the LCD screen.

5 Press the shutter button halfway down to lock the auto 

focus. 

6 When the camera status light stops flashing and you see 

a green circle  on the screen, press the shutter button 

the rest of the way down.

7 Hold the camera still until it beeps. Then release the 

shutter button.

After a moment, you see a confirmation message. Then 

you see the message Sound recording... and a 

countdown of the recording time.

8 Speak clearly into the microphone. You see another 

confirmation message indicating that the recording was 

successful.

current audio setting
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NOTE

Even if you don’t speak into the microphone, your camera records 

ambient noise when recording is turned on, and your images take 

up more space on the memory card. To fit more images on your 

memory card, make sure you turn recording off when you no 

longer want to use it.

Using Programmed Subject Settings

The Program user mode provides four programmed settings 

that let you choose the type of shot you’re taking. The 

camera automatically assigns the optimum exposure, 

metering method, and sensitivity for your subject.

◗ Normal Appropriate for most photographs. Uses 

the following settings: auto exposure, 

matrix metering.

◗ Sports Recommended for action photographs. 

Uses the following settings: high shutter 

speed, automatic sensitivity, matrix 

metering. 

◗ Portrait Recommended for portraits. Uses the 

following settings: spot metering, 

aperture fixed at f/2.4.

◗ Landscape Recommended for landscapes or scenery. 

Uses the following settings: matrix 

metering, aperture set to f/8.0. (The 

aperture automatically changes to f/2.4 

when the subject is dim.)

Follow these steps to use programmed subject settings:

1 Set the camera to Program user mode. (See page 4-2 for 

instructions.)
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2 Open the lens cover and turn the camera dial to . You 

see the View menu.

3 Hold down the MENU button (under PRESS or 

HOLD) until you see the following screen:

4 Press the ISO button to cycle through the four subject 

settings.

5 When you’ve made your setting, press the MENU 

button (under BACK) to save it.

Your subject setting appears in the upper left corner of 

the View menu. 

6 Take your picture. (See page 2-6 for instructions.)

subject setting

subject 
setting
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Adjusting the Sensitivity Setting

If you’ve set the user mode to Program or Manual, you can 

use the LCD screens to adjust the sensitivity setting. (You 

can also use the camera’s ISO button to adjust this setting. 

See page 3-5.)

With the PhotoPC 800’s high sensitivity settings, you can 

take pictures of fast-moving subjects, or indoor pictures 

without a flash. You can set the sensitivity from the camera’s 

standard ISO equivalent of 100 to an ISO equivalent of 200 

or 400.

NOTE

Since image quality is lower when you use high sensitivity 

settings, the standard setting is recommended for most pictures.

The arrow icons above the ISO button indicate the 

sensitivity setting:

The standard setting is equivalent to ISO 100. This 

is the recommended setting for most pictures.

The high sensitivity setting is equivalent to 

ISO 200.

The super high sensitivity setting is equivalent to 

ISO 400.

Follow these steps to adjust sensitivity:

1 Make sure the camera is set to Program or Manual user 

mode. (See page 4-2 for instructions.)

2 Open the lens cover and turn the camera dial to . You 

see the View menu.

sensitivity setting
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NOTE

This View menu illustrates what you see if your user mode is 

set to Program. Your View menu will look slightly different if 

the user mode is set to Manual.

3 Do one of the following:

If user mode is set to Program, the current sensitivity 

setting appears above the ISO button. (See the previous 

illustration.) Press the ISO button to change the 

sensitivity setting. 

If user mode is set to Manual, hold down the MENU 

button (under PRESS or HOLD) until you see the 

following screen. Press the ISO button to change the 

sensitivity setting, then press the MENU button to save 

your setting.

Adjusting the White Balance Setting

Although the PhotoPC 800 adjusts white balance for you 

automatically to ensure color accuracy, you may sometimes 

want to change this setting for special effects (for example, to 

retain the red tints in a sunset).

sensitivity setting

Altair.book  Page 18  Thursday, July 1, 1999  3:33 PM



Using the LCD Menus to Change Settings  4-19

A

B

4

The PhotoPC 800 includes the following white balance 

settings:

AUTO Adjusts the white balance of your pictures 

automatically. This is the recommended setting 

for most pictures.

FIX Locks the white balance setting at 5200 °K. 

CUST Lets you customize the white balance setting. 

See page 4-21 for details. 

You must be in Program or Manual mode to adjust the white 

balance setting. See page 4-2 for information about changing 

the user mode.

NOTE

If you’re using the viewfinder, you can also press the W.B. button 

to change the white balance. See page 3-6 for details.

Photographing With Fixed White Balance

The fixed white balance setting gives your pictures a warmer 

appearance under fluorescent lighting. It’s also a good choice 

for retaining the reds in a sunset.

Follow these steps to lock the white balance setting at 

5200 °K:

1 Make sure the camera is set to Program or Manual user 

mode. (See page 4-2 for instructions.)

2 Open the lens cover and turn the camera dial to . You 

see the View menu.
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3 Do one of the following:

If user mode is set to Program, the current white balance 

setting appears above the W.B. button. Press the W.B. 

button to select FIX. 

If user mode is set to Manual, hold down the MENU 

button (under PRESS or HOLD) until you see the 

following screen. Press the W.B. button to select FIX, 

then press the MENU button (under Back) to save your 

setting.

white balance setting

white balance setting
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Photographing With User Defined White 

Balance

Follow these steps to customize the white balance setting:

1 Turn the camera dial to  to display the SETUP menu. 

If necessary, change to Program or Manual user mode.

2 Press the MENU button (under Camera SETUP) to 

go to the Camera SETUP menu.

3 Open the lens cover. 

4 Press the bottom button (next to the entry New W/B). 

You see the following screen:

5 Press the bottom button (next to Yes) to save a new 

white balance setting.

You see a message instructing you to press the shutter 

button to set a new white balance.

6 Focus the camera on a piece of white paper, or some 

other object to set white balance by, and press the 

shutter button to save the setting.

7 Open the lens cover and turn the camera dial to . You 

see the View menu.
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8 Do one of the following:

If user mode is set to Program, the current white balance 

setting appears above the W.B. button. Press the W.B. 

button to select CUSTOM. 

If user mode is set to Manual, hold down the MENU 

button (under PRESS or HOLD) until you see the 

following screen. Press the W.B. button to select 

CUSTOM, then press the MENU button (under Back) 

to save your setting. 

Adjusting Exposure

Your camera normally adjusts exposure automatically. 

However, you may want to increase the exposure setting if 

you want to lighten your picture or if you’re taking pictures 

of an object against a bright background, such as sand or 

snow on a sunny day. Similarly, you may want to decrease it 

if you want to darken the picture, or if you’re taking pictures 

against a dark background.

With the PhotoPC 800, you can select predefined exposure 

settings, or you can fine-tune the exposure manually by 

setting the shutter speed and aperture setting. 

NOTE

If you’re using the viewfinder, you can also use the camera’s 

controls to make predefined exposure adjustments. See page 3-7 

for instructions.

white balance setting
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Making Predefined Exposure Adjustments

Follow these steps to make predefined exposure adjustments:

1 Make sure that the camera is set to Program or Manual 

user mode. (See page 4-2 for details.)

2 Open the lens cover and turn the camera dial to .

3 Do one of the following:

In Program mode, press the + button (next to the up 

arrow) to increase the exposure setting, or the − button 

(next to the down arrow) to decrease it. You can make 

nine different settings in increments of 0.5, from 

−2.0 to +2.0 EV (Exposure Value).

In Manual mode, press the ISO button (under 

Exposure) to select AUTO, then press the + button to 

increase the exposure setting, or the − button to decrease 

it. You can choose from 21 settings in increments of 0.2, 

from −2.0 to +2.0 EV.

NOTE

Exposure Value is a combination of shutter speed and aperture 

setting.exposure 
setting

set exposure mode to AUTO

adjust 
predefined 
exposure 
settings

Altair.book  Page 23  Thursday, July 1, 1999  3:33 PM



4-24   Using the LCD Menus to Change Settings

Making Advanced Exposure Adjustments

Experienced photographers can set the exposure manually by 

adjusting the shutter speed and aperture.

Follow these steps to set the shutter speed and aperture:

1 Make sure that the camera is set to Manual user mode. 

(See page 4-2 for details.)

2 Open the lens cover and turn the camera dial to .

3 Press the ISO button (under Exposure) to change the 

exposure mode to MANUAL.

4 Press the + button (next to the up arrow) to increase 

shutter speed, or the − button (next to the down arrow) 

to decrease it.

NOTE

When the flash is set to automatic or forced flash, you can 

select shutter speeds from 1/30 to 1/750. When the flash is 

turned off, you can select shutter speeds from 1/2 to 1/750. 

See page 3-3 for instructions on setting the flash.

5 Press the W.B. button to change the aperture setting. 

(You can choose either F2.4 or F8.)

Adjusting the Focus 

The PhotoPC 800 lets you adjust the distance of the focal 

point. Follow these steps:

1 Make sure that the camera is set to Manual user mode. 

(See page 4-2 for details.)

2 Open the lens cover and turn the camera dial to .
set exposure mode to MANUAL

set shutter 
speed
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3 If you want to use the macro feature or take panoramas, 

press the button next to Normal Frame until Macro 

or Panorama appears in the center of the screen.

4 Hold down the MENU button (under PRESS or 

HOLD) until the following screen appears:

5 Press the + or − button (next to the up and down 

arrows) to select a manual focus setting.

If the camera is set to Normal Frame or Panorama, 

you can choose from the following settings:

AF The camera determines the focus automatically.

Focal point is about three feet.

Focal point is about 10 feet.

Focal point is infinity (∞).

If you’re using the macro feature, you can choose a 

setting from 1 to 10, where 1 is the closest possible 

focus.

Changing the Metering Method

If you’re using Manual mode, your camera lets you choose 

between matrix metering and spot metering.

With matrix metering, the camera automatically measures 

the available light and determines the correct exposure. If 

you’re an advanced photographer, you can use spot metering 

to choose a point that the camera samples to determine 

exposure.

focus setting
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Follow these steps to change the metering system:

1 Make sure that the camera is set to Manual user mode. 

(See page 4-2 for details.)

2 Open the lens cover and turn the camera dial to .

3 Hold down the MENU button (under PRESS or 

HOLD) until you see the following screen. The current 

metering setting is in the lower right corner.

4 Press the bottom button (beside Metering) to change 

the setting.

5 Press the MENU button (under BACK) to save your 

setting.

Setting Camera Options

You can change the settings of several camera options, 

including the automatic power off feature, the LCD screen’s 

brightness, and when and whether the camera beeps. You 

can also reset the camera’s clock and language.

NOTE

You can also set the camera’s clock and automatic power off 

feature from your computer. See Chapter 10 for details.

Setting the Automatic Power Off Feature

The automatic power off feature saves battery power by 

automatically turning your camera off when it’s idle for a 

designated period of time. You can set the camera to turn off 

after 10 seconds, 30 seconds, one minute, or three minutes.metering 
setting
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Follow these steps to change the power off interval:

1 Push the camera dial lock in and turn the dial to . You 

see the SETUP menu.

2 Press the MENU button (below Camera SETUP) to 

go to the Camera SETUP menu. The current power off 

setting appears in the upper right corner of the screen. 

3 Press the top button (next to the current setting) to 

select a new setting.

NOTE

Automatic power off is only in effect when you’re using batteries 

to power the camera. 

power off 
setting
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Setting the LCD Brightness

To adjust the brightness of the LCD screen, follow these 

steps:

1 Turn the camera dial to  to display the SETUP menu. 

Then press the MENU button (under Camera 

SETUP). You see the Camera SETUP menu.

2 Press the + or − button (next to the up and down 

arrows) to adjust the screen brightness.

Setting the Alert Beep

Normally, the camera’s alert beep lets you know when an 

image has been captured. However, you can turn the alert 

beep off, or set the camera to beep whenever you press any of 

its buttons.

To set the alert beep, follow these steps:

1 Turn the camera dial to  to display the SETUP menu. 

Then press the MENU button (below Camera 

SETUP). You see the Camera SETUP menu.
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2 Press the W.B. button (under Beep) to cycle through 

these choices:

◗ Shutter The camera beeps when an image is 

captured.

◗ Never Turns the beep off.

◗ Always The camera beeps whenever you press 

a button.

Setting the Time and Date

The camera remembers the time and date settings you made 

when you formatted your memory card, unless it goes 

without battery power for more than a couple of hours. If 

you need to reset the time and date for any reason, follow 

these steps:

1 Turn the camera dial to  to display the SETUP menu. 

You see the camera date and time setting in the upper 

right corner of the screen.

2 Press the top button (next to the setting) to display the 

following screen. The month is highlighted in red.

camera date 
and time 
setting
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3 Press the + or − button (next to the up and down 

arrows) to adjust the setting, then press the W.B. button 

(under the right arrow) to highlight the day.

4 Repeat step 3 for each item you want to change. (To 

return to a previous setting, press the ISO button.)

5 When you’re done, press the MENU button (under 

BACK) to save the setting and return to the SETUP 

menu.

Setting the Language

You can choose from two languages for information 

displayed on the LCD screen. 

Follow these steps to change the language setting:

1 Turn the camera dial to  to display the SETUP menu. 

2 Press the ISO button (under the  icon) to go to the 

language setting screen.

3 If necessary, press the W.B. button (under the right 

arrow) to highlight ENG.

4 Press the MENU button (under BACK) to save the 

setting and return to the SETUP menu.
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he LCD screen lets you play back your pictures one-Tby-one or in groups of four or nine. You can magnify 

or delete selected pictures and customize playback features. 

You can also view your pictures on a television as easily as on 

the camera’s screen. This chapter explains the following:

◗ Playing back pictures one-by-one or several pictures 

at a time

◗ Deleting pictures 

◗ Locking pictures

◗ Adding and deleting audio recordings

◗ Magnifying pictures

◗ Viewing detailed information about a picture

◗ Playing pictures as a slide show

◗ Playing back pictures on TV

Playing Back Photos 
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NOTE

After a designated period of inactivity, the camera 

automatically shuts off to conserve battery power. If the 

image on your LCD screen disappears, press any button on 

the back of the camera to “wake” the camera.

Playing Back Pictures One by One

When you set the camera dial to , you see the last picture 

you took on the LCD screen:

Press the + button (next to the right arrow) to display the 

earliest picture taken. You can continue pressing the + 
button to view your pictures in order. Press the − button 

(next to the left arrow) to move backward through your 

pictures.

MENU

+

–

ISO W.B.

top button

bottom button

picture number

display multiple images
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Playing Back Multiple Pictures

You can play back your pictures in Multi mode to view small 

“thumbnail” versions of either four or nine pictures at once. 

Follow these steps to play back multiple pictures:

1 Turn the camera dial to . You see the last picture you 

took on the LCD screen.

2 Press the ISO button (below Multi). 

Small thumbnail images of the last four pictures you 

took appear on the screen, with the currently selected 

image framed in white. 

3 If you want to display nine pictures at once, press the 

ISO button (under 1x9) again.

4 Press the + and − buttons to move the white selection 

frame through the images on screen, or hold one of these 

buttons down to move through the images quickly.

When the frame passes the first or last image of the 

current group, the previous or next three images are 

displayed in the group.

5 To switch back to displaying one picture at a time, press 

the ISO button again.

press the + or − 
button to move 
through images
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Deleting Pictures

The LCD screen provides two different methods for deleting 

images after you play them back: 

◗ You can delete the currently displayed picture

◗ You can select multiple pictures for deletion, or “lock” 

(protect) them from deletion

You can also delete images through your software when the 

camera is connected to your computer. For instructions, see 

Chapter 6.

Deleting the Currently Displayed Picture

Make sure the camera dial is set to , then follow these 

steps:

1 Press the + or − button (next to the right and left arrows) 

to display the image you want to delete.

NOTE

To make choosing images easier, you can display four or 

nine images at a time by pressing the ISO button once or 

twice.

2 Press the W.B. button (under Delete). A confirmation 

message appears.

3 Press the top button (next to Yes) to delete the image, 

or the bottom button (next to No) to cancel.

NOTE

If you try to delete a locked image , you see a warning 

message. Press any button to clear the message. See pages 5-6 

for instructions on locking and unlocking images in the camera.
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Deleting All Pictures

To delete all the images from your memory card, make sure 

the camera dial is set to , then follow these steps:

1 Press the bottom button (next to Select Image). Then 

press the top button (next to Select All) to select all the 

images in your card.

2 Press the ISO button (under Delete) to delete the 

images. A confirmation message appears.

3 Press the top button (next to Yes) to delete the images, 

or the bottom button (next to No) to cancel.

NOTE

If any images are locked, you see a message asking if you want 

to delete them. Press the button next to No to delete only the 

unlocked images, or next to Yes to delete the locked images too. 

See page 5-8 for instructions on unlocking images.

Deleting Selected Pictures

Make sure the camera dial is set to , then follow these steps:

1 Press the ISO button (under Multi) once to display four 

pictures on the screen, or twice to display nine. A white 

frame appears around one of the pictures.

2 Press the button next to Select Image. You see the 

following on your screen:
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3 Press the + or − button (next to the right and left arrows) 

to move the frame to an image you want to erase. Then 

press the bottom button (next to Select). A red frame 

appears around the image and the word Select changes 

to Release.

NOTE

If you change your mind, press the button next to Release to 

deselect the image.

4 Repeat step 3 to select any additional images.

5 After you’ve finished selecting images, press the ISO 

button (under Delete) to delete them.

A confirmation message appears. Press the top button 

(next to Yes) to delete the selected images, or the 

bottom button (next to No) to cancel.

Locking Pictures

The lock feature allows you to keep your images from being 

accidentally deleted. You can lock selected images or all the 

images in the camera. Make sure the camera dial is set to , 

then follow these steps to lock pictures:

1 Press the ISO button (under Multi) once to display four 

pictures on the screen, or twice to display nine. A white 

frame appears around one of the pictures.

2 Press the bottom button (next to Select Image). You 

see the following on your screen:
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3 Do one of the following:

◗ If you want to lock all images, press the top button 

(next to Select All). (If you change your mind, 

press the same button to deselect all images.)

◗ If you want to lock just one or some of the images, 

press the + or − button to move the frame to an 

image you want to lock. Then press the bottom 

button (next to Select). (If you change your mind, 

press the button next to Release to deselect the 

image.) Repeat this step for each image you want to 

lock.

A red frame appears around each image selected.

4 Press the W.B. button (under the padlock icon). You see 

the following on your screen:

5 Press the button next to Lock.

A padlock icon appears in the upper left corner of each 

locked image.

6 Press the MENU button (under BACK) to save your 

settings.
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Unlocking Pictures

After you have locked some of your pictures, you can unlock 

selected pictures or all the pictures in the camera. 

Make sure the camera dial is set to , then follow these steps:

1 Repeat steps 1 through 3 of “Locking Pictures” to select 

the images you want to unlock.

2 Press the W.B. button (under the padlock icon). You see 

the following:

3 Press the bottom button (next to Release).

The selected images are unlocked. If an image is 

successfully unlocked, the padlock icon disappears from 

the upper left corner of its frame. 

4 Press the MENU button (under BACK) to save your 

settings.

Adding Audio Recordings

You can add audio recordings to images stored on your 

memory card.

NOTE

You can’t add audio recordings to images taken in quick shot 

mode.
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Follow these steps to add a recording to an existing image:

1 Turn the camera dial to  to go to playback mode.

2 Press the + or − button (next to the right and left arrows) 

to move to the photo to which you want to add a 

recording. (If you’re displaying multiple images, you’ll 

see a white frame around the currently selected photo.)

3 Hold down the MENU button (under HOLD to 

NEXT) until the screen changes, then press the top 

button (next to RECORD). You see the following:

4 Press the button next to the desired recording time. A 

countdown of the recording time appears on the screen.

NOTE

If there’s already a message on the selected photo, a 

confirmation message appears after you choose the 

recording time. To erase the old recording and make a new 

one, press the top button (next to Yes). Or press the bottom 

button (next to No) to cancel.
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5 Speak clearly into the microphone on the back of the 

camera.

A microphone icon appears in the upper left corner of 

the image to indicate that a recording has been added.

Deleting Audio Recordings

You can also delete audio recordings that you’ve added to the 

pictures on your memory card. 

Make sure your camera dial is set to , then follow these 

steps:

1 Press the ISO button (under Multi) once to display four 

pictures on the screen, or twice to display nine. A white 

frame appears around one of the pictures.

2 Use the + or − button (next to the right and left arrows) 

to move to an image whose attached recording you want 

to erase. (You’ll see a microphone icon in the upper left 

corner if the image has a recording attached.)

3 Hold down the MENU button (under HOLD to 

NEXT) until you see the following:

4 Press the button next to RECORD. You see the 

following on your screen:
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5 Press the ISO button (under Sound Delete) to delete 

the recording for this picture. A message appears asking 

you to confirm the deletion.

NOTE

If you see a message that the selected image is locked, 

press the button next to Unlock to unlock it.

6 Press the button next to Yes to confirm, or No to 

cancel.

7 Press the MENU button (under BACK) twice to return 

to the playback menu.

Magnifying a Picture

You can zoom in to magnify a portion of your image on the 

LCD screen and view it in greater detail. Then you can use 

the camera’s buttons to scroll the image and display another 

section (up to nine sections for regular images and three 

sections for panoramic images).

The sections of your image that can be viewed are 

demonstrated in the figure below:

Make sure the camera dial is set to , and follow these steps:

1 To magnify the currently displayed image, press the top 

button (next to the magnifying glass icon).

A magnified view of the center section of the picture 

appears. An icon in the top left corner of the screen 

indicates which section of the image is currently 

displayed.

2 To view different sections of the magnified image, press 

the + and − buttons (next to the up and down arrows) to 

move up or down, or the ISO and W.B. buttons (next 

to the left and right arrows) to move left or right.

The center 
section is 
magnified first
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NOTE

When you magnify a panoramic picture, it’s divided into 

three parts. You can only scroll left and right.

3 To exit the magnification screen, press the MENU 

button (next to BACK).

Viewing Picture Information

You can use the LCD screen to view detailed information 

about individual images, including date and time taken, 

shutter speed, exposure settings, aperture and white balance 

settings, and metering method. To display image 

information, follow these steps:

1 Turn the camera dial to , then hold down the MENU 

button (under HOLD to NEXT). 

You see the following screen:

2 Press the W.B. button (below INFO) to display 

information for the currently selected image.

3 Press the MENU button (under BACK) to exit the 

picture information screen.
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Playing Your Pictures as a Slide 

Show

You can use the LCD screen to play back your pictures in a 

continuous “slide show.” You can even control the slide 

show’s speed and pauses.

Follow these steps:

1 Turn the camera dial to . Then hold down the MENU 

button under HOLD to NEXT) until the following 

screen appears:

2 Press the bottom button (next to SLIDE SHOW). You 

see the following screen:

3 Press the + button to select the slide show speed. (You 

can have the image change automatically every 3, 5, or 

10 seconds, or you can choose to change the images 

manually.)

NOTE

You can also rotate the images, or exclude certain images 

from your slide show. See the following sections for 

instructions.

slide 
show 
speed
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4 Press the bottom button (next to Start) to begin the 

slide show.

To pause the slide show, press the MENU button; then 

press the MENU button again to restart it. While the 

slide show is paused, you can view the last image by 

pressing the ISO button (under BACK).

To stop the slide show, press the bottom button (next to 

Quit).

Excluding Pictures From a Slide Show

All pictures saved in your camera’s memory card are 

automatically included in the slide show. To exclude any 

pictures from the slide show, follow these steps:

1 Turn the camera dial to . Then hold down the MENU 

button (next to HOLD to NEXT) until you see the next 

screen.

2 Press the bottom button (next to SLIDE SHOW). You 

see the following screen:

3 Press the − button (next to SlideSelect). The following 

screen appears:
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4 Press the + or − button (next to the right and left arrows) 

to select the picture you want to exclude from the slide 

show. (If you want, press the ISO button to display 

multiple pictures.) 

5 Do one of the following:

◗ Press the bottom button (next to Exclude) to 

exclude the selected picture.

◗ Press the top button (next to Excld All) to exclude 

all pictures.

NOTE

If you change your mind, move the white frame to the 

picture you want to include again and press the bottom 

button (next to Select). Or press the top button (next to 

Select All) to include all pictures.

6 When you’re finished, press the MENU button twice to 

return to the playback menu.

Rotating Pictures in a Slide Show

You can display pictures in your slide show rotated 90 

degrees to the right or left. To rotate a picture, follow these 

steps:

1 Turn the camera’s dial switch to  to display the 

playback menu, then hold down the MENU button 

(under HOLD to NEXT) until you see the next screen.
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2 Press the bottom button (next to SLIDE SHOW). You 

see the following:

3 Press the − button (next to SlideSelect) to display the 

following:

4 Press the + or − button (next to the right and left arrows) 

to frame the image you want to rotate. Then press the 

bottom button (next to Select) to select the image. 

NOTE

To make it easier to view your picture, press the ISO button 

to display multiple images, then use the + or − button to 

select an image.

5 To rotate the image 90 degrees to the right, press the 

W.B. button (under Rotate) once. An orientation icon 

 appears in the upper left corner of the screen 

indicating that the picture will be rotated to the right 

when displayed in the slide show.

To rotate the image 90 degrees to the left, press the 

W.B. button twice. A left orientation icon  appears in 

the upper left corner of the screen.

6 Repeat steps 4 and 5 to rotate more pictures. When 

you’re finished, press the MENU button (under BACK) 

to save your changes.
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Playing Back Pictures on TV

You can display your pictures on a regular television 

or VCR by using the video cable that came with your 

PhotoPC 800. 

TIP

You can videotape your pictures to share them without using a 

computer. After you connect the camera to your VCR, press the 

Record button on the VCR and use the camera’s slide show 

feature, as described on page 5-13.

Follow these steps to play back your pictures on TV:

1 Make sure the camera and TV (and VCR) are turned off.

2 Open the camera’s connector cover and connect the 

black end of the video cable to the Video Out port, as 

shown.
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3 Connect the yellow end of the cable to the VIDEO IN 

port on the television or VCR.

4 Turn on the TV (and VCR) and switch to the correct 

video mode.

5
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6 urn the camera dial to . The last picture you took 

appears on the TV screen. You can use all of the 

camera’s playback features when your pictures are 

displayed on TV.

NOTE

Using the optional AC adapter is highly recommended when you 

play back your pictures on a TV. See page A-2 for instructions and 

ordering information.
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.

hen you’re finished taking pictures, you can connect Wthe camera to your computer and transfer the 

images. Then you can use the pictures on your Web site, in 

presentations, or in just about anything you create on your 

computer. This chapter describes the following:

◗ Connecting the camera

◗ Transferring photos and sound files with Image Expert

◗ Getting images into TWAIN-compliant applications

◗ Getting images that you can import

NOTE

If your computer has a Type II PCMCIA card slot, you can transfer 

your pictures by copying them directly from your memory card. 

See page A-4 for instructions.

6   

Connecting the Camera

Note the following before you start:

◗ If you have the optional AC adapter, you can conserve 

battery life by using it when you connect the camera to 

your computer. See page A-2 for instructions.

The AC adapter should be available where you bought 

your PhotoPC 800. Or see page A-2 for information on 

ordering an AC adapter through EPSON Accessories.

◗ When you connect the camera, make sure your system is 

not exposed to sources of electromagnetic interference, 

such as stereo speakers or the base units of cordless 

telephones.

Getting Photos Into Your Computer

Altair.book  Page 1  Thursday, July 1, 1999  3:33 PM



6-2   Getting Photos Into Your Computer

Connecting to a Windows PC

You can connect the camera to your USB-enabled 

Windows 98 system with either the Windows serial cable or 

the USB cable that came with the camera.

If you’re using the USB cable and you see the New Hardware 

Found screen, follow the instructions on page 1-15.

Using the USB Cable

Follow these steps to connect your camera using the USB 

cable:

1 Plug the connector on the USB cable into the USB port 

on your computer, or into a port on a USB hub.

NOTE

Although you can use a USB hub, it’s recommended that you 

connect the camera directly to the computer’s USB port.

2 Open the connector cover on the side of the camera. 

Then insert the connector on the other end of the USB 

cable into the camera’s interface port. 

3 Turn on the camera by turning the camera dial to .
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Using the Windows Serial Cable

Locate the Windows serial cable that came with the camera, 

then turn off the camera and your computer.

Follow these steps to connect the camera to your computer:

1 Locate a serial port on the back of your computer. You 

may have two serial ports labeled COM1 and COM2, or 

the ports may be labeled with icons. If you have two 

serial ports available, use COM1 (port 1) to connect 

your camera.

NOTE

If you have a 25-pin serial port, you can use a 9- to 25-pin 

adapter.

2 Line up the serial connector on the cable with one of the 

serial ports on your computer, and insert the connector. 

Then tighten the screws. 

3 Open the connector cover on the side of the camera. 

Carefully insert the connector on the other end of the 

cable into the camera’s interface port. 
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4 Turn on the camera by turning the camera dial to , 

then turn on your computer system. 

NOTE

If you have problems connecting to the COM port you have 

selected, check your computer’s COM port configuration and 

try again.

Connecting to a Macintosh

You can connect the camera to your PowerPC with the 

Macintosh serial cable that came with your camera. If you 

have an iMac or PowerMac G3, you can use the USB cable. 

See page 6-2 for instructions on connecting the camera with 

a USB cable.

Follow these steps to use the Macintosh serial cable:

1 Turn off the camera and your Macintosh.

2 Locate the modem port  or printer port  on 

the back of your Macintosh. You can use either port to 

connect the camera.

NOTE

If you’re sharing a serial port that you use for another device, 

make sure AppleTalk™ is turned off. Your Macintosh may 

not recognize the camera if AppleTalk is on. Also, if you have 

problems connecting to the printer port, use the modem port 

instead.
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3 Open the connector cover on the side of the camera. 

Carefully insert the connector on the other end of the 

cable into the camera’s interface port.

.

4 Turn on the camera by turning the camera dial to , 

then turn on your Macintosh system.

On a PowerPC or G3 Macintosh (or a Windows PC with a 

high-speed serial board), you may be able to transfer your 

pictures at the rate of 230.4KB per second. If your camera 

software doesn’t set this speed automatically, you can set it 

manually. See page 10-6.

Transferring Photos and Sound Files 

The PhotoPC 800 provides several different ways to transfer 

your pictures from the camera’s memory card to your 

computer. The simplest method is to use the Image Expert 

software that came with your camera. This lets you view 

small thumbnail images of your pictures, and then quickly 

transfer them to an album (folder) on your hard disk drive.

If you haven’t installed your software, do it now. (See 

Chapter 1.) Make sure the camera is connected to your 

computer and the camera dial is turned to .
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NOTE

Although these instructions apply to Windows 95 and 98, the 

same steps can be used with a Macintosh or Windows NT 4.0 

system.

1 Start Image Expert. Click Start, and then point to 

Programs, Image Expert, Image Expert. 

If you see the Image Expert Quick Tour screen, click 

Close. (This screen does not appear on the Macintosh.)

You see a window like the following:

2 Click View Pictures in the Camera. You see a 

window displaying “filmstrips” of your images. (If you 

see an error message instead, see page 6-9.)

3 Click the  button to transfer all the images to your 

hard drive. To transfer a single image, select it, then 

click the button.

click to see 
the pictures 
in your 
camera

click to start transferring your photos
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NOTE

◗ To select more than one image, hold down the Ctrl key 

while you click. To deselect, click another image.

◗ You must click the  button to transfer images. When you 

view camera images on your computer, you have not yet 

transferred them.

You see a Select Album window like the following:

type here if you 
want to rename 
your album

type here if you 
want to rename 
your album

Macintosh

Windows
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Image Expert will automatically create an album (folder) 

for your pictures with the current date as its name. You 

can type your own name for the album if you want, or 

choose an existing album. 

4 Click Open (or OK on a Macintosh) to begin 

transferring your pictures. You see a confirmation 

message asking if you want to download selected images 

only.

5 Click Selected to download the selected images, or All 

to download all images. A window like the following 

appears to show you the progress of each image:

6 When you’re finished, close the filmstrip window. 

7 To erase all images from the camera’s memory card, 

select Erase All Images from the Camera menu. To 

erase a particular image, click the image to select it and 

choose Delete from the Edit menu. You see a 

confirmation message.

8 Click Yes to erase the image(s), or No to cancel.

You can double-click an image to open it in Image Expert. 

You can display your images one by one, edit, print, and 

copy them to diskettes, or place them in your documents and 

presentations. See Chapters 7, 8, and 9 for more information 

about working with images in Image Expert.

click if you want to stop 
transferring images
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What To Do if You See an Error Message

When you click the button to view images in the camera’s 

memory card, you may see a message like the following:

Follow these tips to get your camera connected correctly:

1 Make sure the camera is turned on and has not shut off 

automatically. If it has, turn the camera dial to Off, then 

to .

2 Check the cable and make sure the connections are 

secure. Make sure the pins inside the connector are not 

bent.

3 Make sure your batteries have enough power, or your 

AC adapter is connected.

4 Click Retry. If you see the Connection Failed 

message again, click Connection.

You see the following dialog box:

5 Select another image source, if necessary. If you’re using 

a PCMCIA adapter to access images from a PC card 

slot, select PC Card. 

6 Select another port if necessary. In most cases, it’s best to 

leave the Port setting at Auto because Image Expert can 

detect the camera connection automatically. 

If you have a serial device connected to one port and an 

internal modem on the other, you can try setting the 

Port to COM3 or COM4.
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If you have a USB port, try selecting USB, then 

remove the USB cable from your computer and 

reconnect it.

7 Select a slower speed. Image Expert automatically 

chooses the fastest speed that works with your system, 

but this may actually be too fast for the configuration of 

your port. Try setting the speed to 57600. You may 

need to experiment to choose the best speed.

8 When you are finished, click OK.

Getting Images Into TWAIN-

Compliant Applications

If you use Adobe Photoshop or other TWAIN-compliant 

applications, you can transfer your pictures directly into your 

program from the camera. Follow these steps:

1 Start your application. 

2 Choose Import, then Select TWAIN_32 Source if 

you’re running Windows (or Import, then TWAIN 

Select if you have a Macintosh) from the File menu.

NOTE

The commands you choose from the File menu differ from 

one host application to another. With other host applications, 

you might choose Acquire or Select Source.

3 For your TWAIN source, choose EPSON 

PhotoPC 800 (Windows), or PhotoPC 800 

(Macintosh).

For Windows, choose Import, then TWAIN_32 from 

the File menu. For Macintosh, select Import, then 

TWAIN_Acquire.
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The EPSON Photo!3 screen appears, with thumbnail 

images of your photos. (If you see the message The 

Camera Is Not Responding, see page 6-14.)

4 Select the picture you want and click Get Photos to 

transfer the picture. Or click Select All and then Get 

Photos to transfer all the pictures.

You can also select a picture and do the following before 

you transfer it:

◗ Click View Photo to see a full-size image.

◗ Click one of the rotation buttons to turn the picture 

90 degrees.

◗ Click Photo Info to see the capture time and date, 

image resolution, and other information.

◗ Check PhotoEnhance to automatically improve 

the picture during transfer. (You can select and 

enhance all the pictures at once. However, using 

this feature will make the transfer take significantly 

longer. This feature is not recommended unless 

you’re using the AC adapter.)

5 After transferring, click Erase Photos if you want to 

remove the picture(s) from your camera.

6 If necessary, click Close to exit the EPSON Photo!3 

screen and return to your application. You see the 

picture or pictures in the work area.

click to transfer 
your picture(s)

click if you 
need help
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Getting Images That You Can Import

Most methods of transferring images from the camera save 

your pictures as JPEG files. If your word processor or other 

application doesn’t support the JPEG format, you have to 

convert the files one by one. Or you can use the export 

feature of EPSON Photo!3 to automatically convert the files 

as you transfer them. 

Follow these steps to export and convert your pictures with 

EPSON Photo!3:

1 Start your EPSON Photo!3 software. Under 

Windows 95 or 98, click Start, and then point to 

Programs, EPSON Photo!3 Ver.1, EPSON 

Photo!3 Ver.1.

You see a screen like the one below. (If you see a Setup 

screen that says The Camera Is Not Responding, see 

page 6-14.)

2 Click the picture you want, or click Select All.

You can also view, rotate, or enhance the picture(s) or 

see picture information before you export, as described 

on page 6-11.

click to transfer and 
convert picture(s)
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3 Click the Export Photos button. The Save As dialog 

box appears:

4 Type a file name. If you’re exporting more than 

one image, the software will add numbers to identify 

each one.

5 Select the file type from the pull-down menu. You can 

choose any of the following formats:

◗ PICT (Macintosh only)

◗ JPEG

◗ Bitmap (BMP)

◗ PCX

6 Click Save. Your pictures are transferred one by one.

NOTE

You cannot open exported photos in EPSON Photo!3. Use 

Image Expert to view and edit the exported images.

7 Click Erase Photos if you want to remove the pictures 

from your camera.

type a name 
for your 
photo(s)

click to transfer 
and “export” 
photos

click if you want to 
choose a different folder

click to choose 
the file type

click if you want to 
create a new folder
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Here are some additional things you can do with 

EPSON Photo!3:

◗ Select the Folder tab and click Browse to locate 

and display pictures you have downloaded. You can 

then select a picture and click Upload to transfer a 

picture from your computer to the camera or an 

optional memory card. See Chapter 11 for more 

information.

◗ Select the Controls tab to change camera settings 

or view a live preview and take pictures from your 

computer. See Chapter 10 for more information.

◗ Set the camera’s date and time from the Setup tab, 

or change your computer connection settings. See 

Chapter 10 for more information.

8 Click Close to exit EPSON Photo!3. 

You can now insert your exported pictures in documents and 

other projects. For instructions, see page 7-2.

What To Do If the Camera Is Not 

Responding

When you try to acquire pictures from the camera or start 

the EPSON Photo!3 application, you may see a screen like 

the following:
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Follow these steps to fix your camera connection:

1 Check the cable and make sure the connections are 

secure. Make sure the pins inside the connector are not 

bent.

2 Make sure your batteries have enough power, or your 

AC adapter is connected.

3 Click Test Connection. If you see the same screen, 

continue with step 5.

4 Select another port if necessary. In most cases, it’s best to 

leave the Port setting at Auto because EPSON Photo!3 

can detect the camera connection automatically. 

If you have a serial device connected to one port and an 

internal modem on the other, you can try COM3 or 

COM4.

If you’re using a USB port, try selecting USB, then 

remove the USB cable from your computer and 

reconnect it.

5 Select a slower speed. EPSON Photo!3 automatically 

chooses the fastest speed that works with your system. 

This may actually be too fast for the configuration of 

your port. Try setting the speed to 57600. You may 

need to experiment to choose the best speed.

6 Click Test Connection again. If you still don’t see 

your pictures, see Chapter 13 for more troubleshooting 

tips.
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Gardening Monthly
November 1998

Sunflowers
Sunflowers are big-leafed, sturdy plants that need
full sun and moist soils.  Seeds attract birds.
Perennial species grow rapidly, forming sizable
clumps that can become invasive.  Plant in large
gardens or parks.  Start by division or seed.  All
bloom in late summer and fall.

Recipe of the Month
Grilled Cactus Pads
*  1 pound cactus leaves        * Olive Oil

This is an interesting treat for a cookout.  Scrub cactus leaves
well with a vegetable scrubber to remove any spines that may
be on them.  With the end of a potato peeler cut around the
spiney nodules and remove them. Make sure that all are
removed.  Grill the leaves over charcoal or wood fire for 10
to 12 minutes on each side.  Thicker leaves may take slightly
longer to grill.  Brush leaves with oil occasionally while
grilling.  Serve hot.

New Next Month

Orchid Mania

Landscaping Page 2

Bulbs  Page 3

Book Reviews Page 4

Seeds        Page 5

Supplies        Page 6

Cactus Fever
Large, round or cylindrical cacti with deep
accordianlike ribbing and prominent spines
comprise this group of Mexican and Southwestern
U.S. natives.  They vary in size and shape, but all
are easy to grow and can reach 10 ft. tall and wide.
Spring and summer flowers bloom in pink or
yellow in a circle at the plant’s crown.  Don’t plant
where children are present.

-  Focus on Echinocatus

This print sample was created using actual 1024x768 pixel images taken with the EPSON PhotoPC 600 XGA color digital camera.  It was
printed with the EPSON Stylus Color 600 printer at 1440 dpi on EPSON Photo Quality Glossy Paper.

hotoPC 800 provides several methods for gettingPyour pictures into presentations, letters, and other 

projects. You can drag and drop a picture from an Image 

Expert album into a document or presentation. You can also 

import an image into your application, or copy and paste it. 

With Windows, you can use the Camio™ Viewer to drag a 

picture directly from the camera and drop it into your 

project. This chapter describes the following: 

◗ Importing images into documents

◗ Getting images with copy and paste

◗ Using drag and drop from an album

◗ Getting images with the Camio Viewer

Getting Your Photos Into Documents
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Although most of the instructions and illustrations in this 

chapter apply to Windows 95 and 98, you can follow the 

same steps on a Macintosh or Windows NT 4.0.

Importing Images Into Documents

Once your pictures are transferred and saved on your hard 

drive, you can import them into your applications. You may 

need to convert your images if you didn’t export them from 

the camera (as explained in Chapter 6) and your application 

can’t import JPEG files. Or you can use the Save As feature 

of Image Expert to convert image files.

NOTE

Your picture may display poor image quality after you import it. 

However, in most cases it will print correctly.

Follow these steps to import a PhotoPC 800 picture into 

your document:

1 Start your application.

2 Open the document where you want to use the picture.

3 Select the point where you want to place your picture.

4 Select Picture from the Insert menu. (In some 

applications you may need to select a different 

command, such as Import Picture, which is usually in 

the File menu.) 

An Insert Picture dialog box appears (your dialog box 

may look different, depending on your application):

5 Locate and select the image you want to insert. In some 

applications you can see a preview of your picture.
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6 Click OK (or Insert, Import, or whatever command 

your application uses) to insert your picture. The picture 

appears in your document.

NOTE

In some applications, you can add a frame around the picture if 

you want to move it around on the page or resize it. In other 

applications, you create a frame first and then place the picture in 

it. For instructions, see your application’s online help or 

documentation.

Getting Images With Copy and Paste

You can use this method to place a picture in just about any 

type of document or project. You should already have 

transferred your picture from the camera to your hard disk. 

Follow these steps:

1 Start Image Expert. (See page 6-5.)

2 Click View Pictures from an Existing Album. Or, 

from the Image Expert screen, click the Open Album 

button  or select Open Album from the File menu.
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You see a dialog box like the following:

3 Locate the album you want and double-click it to open 

it. When a filmstrip of album images appears in the 

Image Expert window, click the picture you want to 

copy.

4 Click the Copy button or select Copy from the Image 

Expert Edit menu.

5 Start your word processor or other application.

6 Open the document where you want to use the picture.

7 Choose Paste (or Paste Special) from your 

application’s Edit menu. A copy of the picture appears 

in your document.

Using Drag and Drop From an Album 

(Windows Only)

Once you have transferred your pictures into albums, you 

can easily drag and drop them into documents or other 

projects.

NOTE

Dragging and dropping an image into a document works only with 

OLE-2.0-compliant applications, such as Microsoft Word, 

PowerPoint, WordPerfect, or Lotus SmartSuite. Depending 

on how well your application supports OLE 2.0, your images may 

not look as good when you drag and drop them as when you 

import them.
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Follow these steps:

1 Start Image Expert as described on page 6-5.

2 Click View Pictures from an Existing Album, or 

click the Open Album button  from the Image Expert 

screen. 

3 Locate the album you want and double-click it to 

open it. 

4 Start your word processor or other application.

5 Open the document where you want to use the picture.

You should have both the Image Expert album and the 

document displayed on your screen, as shown:

6 Click the image you want.

7 While holding down the mouse button, drag the image 

to the location where you want it in your document.

8 Release the mouse button. The picture appears in your 

project or document.
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If you want to edit or modify the picture, just double-click it 

on the Image Expert window to bring up the Image Expert 

menus and toolbar.

Getting Images With the Camio 

Viewer (Windows)

The Camio Viewer is a quick and easy way to get pictures 

from the camera. You can transfer all images to your 

computer, or just display the pictures in the camera. Then 

you can drag a picture directly into a presentation or 

document.

NOTE

Dragging and dropping an image with the Camio Viewer works 

only with OLE-2.0-compliant applications running under 

Windows 95, Windows 98, or Windows NT. 

First you need to connect the camera to your computer as 

described in Chapter 6. Then follow these steps:

1 Double-click the camera icon  on the right end of 

your Windows taskbar. 

You see the Camio Viewer Startup Options dialog box:

2 Choose one of the following options:

◗ View images in the Camera

Displays a filmstrip of your pictures. You can then 

select an image to drag and drop into a document or 

presentation. (The image will be embedded in your 

document, and will not be available as a separate 

file.)
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◗ Copy all images from the Camera to 

the Computer

Transfers your pictures to an album (folder) on your 

hard drive. You can then select an image to drag and 

drop.

◗ Copy all images and delete them from 

the Camera

Transfers your pictures to an album (folder) on your 

hard drive and deletes them from the camera. You 

can then select an image to drag and drop.

3 Continue with the steps in one of the following sections, 

depending on the option you chose in step 2.

Dragging and Dropping a Picture Into 

a Document

Follow these steps if you chose View images in the 

Camera:

1 Click OK. Your pictures appear in a strip of thumbnail 

images: 

2 Open the application and document where you want to 

use the picture.
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3 Click the picture you want to use. Without releasing the 

mouse button, drag the picture to your document. 

When your pointer is over the location where you want 

the picture to appear, release the mouse button. The 

picture is downloaded from the camera, and it appears 

in your document.

If you want to edit or modify the picture, just double-

click it in the Camio Viewer filmstrip to bring up the 

Image Expert menus and toolbar. For more information 

about the Camio Viewer, choose Quick Tour from the 

Image Expert Help menu.

NOTE

When you drag and drop with the Camio Viewer, your picture is 

not saved as a separate image file on your hard drive. You have to 

transfer your image first if you want it to be available as a 

separate image file.

Transferring Images Before Placing Them

Follow these steps if you chose Copy all images:

1 Click OK to copy your pictures to an album named with 

the current date. Or, type a new name for the album and 

click OK. Your pictures are transferred one by one. They 

appear in a strip of thumbnail images, as shown on the 

previous page.

2 Follow steps 2 and 3 in the previous section to drag and 

drop a picture into a document or other project.
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ou can use Image Expert albums to organize and Y display your pictures. You can print using dozens of 

predefined layouts. On Windows systems, you can also 

record sounds for each image, copy an album to diskette, use 

your images as wallpaper, and more. This chapter covers the 

following:

◗ Using albums

◗ Printing an image or album 

◗ Adding sound to an image

◗ Displaying albums as slide shows

◗ Using an album as a screen saver

◗ Setting an image as wallpaper

◗ Copying to diskette or Zip™ disk

◗ Sending pictures and sound by e-mail

Working With Photos and Albums
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Using Image Expert Albums

Image Expert albums provide a convenient way to access and 

view your pictures. Here are some of the things you can do 

with albums:

◗ Organize pictures in albums

◗ Rename a picture

◗ View picture information

Organizing Pictures in Albums

Although Image Expert initially sorts your pictures by date, 

you can easily drag and drop images between albums to 

organize them by subject matter or in any way you want. 

Follow these steps to copy or move images from one album 

to another:

1 Open the album you want to copy the images to and the 

album where the pictures are located. 

If you want to create a new album, click the 

New Album button  or select New Album from 

the File menu.

2 Select the image or images you want to move or copy. 

Hold down the Ctrl (Option on Macintosh) or Shift 

key to select multiple images. 

3 To copy or move images, click inside one of the selected 

images and hold down the mouse button.

4 Drag the image(s) to the other album.

new 
album

existing 
album
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5 When the second album is highlighted, let go of the 

mouse button. 

The images are copied to the album. You can sort the 

pictures and save or rename the new album.

Renaming a Picture

You can easily rename a picture displayed in an Image Expert 

album. Follow these steps:

1 Click the picture to select it, then click the name that 

appears above the picture. The name is highlighted.

2 Type in the new name and press Enter or click outside 

of the name area. The new name appears above the 

picture and is saved.

Viewing Picture Information

You can display information about any image file and the 

camera settings that were used to capture it. Follow these 

steps:

1 Click the picture to select it, or double-click it to 

open it.

2 Click the Properties button  or select Properties 

from the Image menu. You see information like the 

following:

click here to change a 
picture’s name

Altair.book  Page 3  Thursday, July 1, 1999  3:33 PM



8-4   Working With Photos and Albums

3 Click the Camera Settings tab to display information 

like the following:

4 Click another image to view its information, or close the 

Properties box.

Printing an Image or Album

Image Expert offers many choices for printing an individual 

picture or album with titles, labels, or any text you want to 

add. You can print an image at full size (one per page) or 

choose the number of prints per sheet of paper. You can also 

specify a size, or print combinations with standard sizes for 

framing. 

Follow these steps to print:

1 Open the image or album you want to print.

2 Click the Print Layout button  or choose Print 

Layout from the File menu. The Print Layout window 

appears:

The image in the center of the screen shows you a 

preview of your printout.

click to display next 
or previous page

click to display list of 
sizes and layouts

click to adjust 
margins
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3 Follow the instructions in the sections below to adjust 

printer settings, choose your layout style, select album 

images, add text, and adjust the printed area for your 

images. 

4 When you’re finished designing your layout, click the 

Print button  to print your picture(s).

Choosing the Layout Style

You can choose portrait or landscape orientation and select 

from a variety of layouts. 

Follow these steps:

1 Click the Print Setup button  if you need to select 

your printer or paper size. Otherwise, all layouts are set 

up for a standard letter-size sheet.

2 Click the Portrait button  or Landscape button  

to change the orientation of the page.

3 Click the down arrow next to the size box to display the 

drop-down list of sizes and layout choices:

4 Choose the size and number of images you want per 

page. If you need a custom size, choose Custom Size. 

You can then enter exact dimensions for your picture, or 

size it interactively in the layout window.

when you’re 
printing an 
album, you 
can choose 
from two 
types of 
contact 
sheets
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5 When the preview shows the layout you want, you can 

click the Print button  or follow the instructions in 

the next sections to add text or make other adjustments 

to your printout.

Adding Text

If you want to have image labels or page headers or footers 

printed with your pictures, follow these steps:

1 Click the Edit Text button . The Change Print Text 

dialog box appears:

2 Select Page Header, Page Footer, or Image Label, 

and then type the text you want to use in the Left, 

Center, or Right boxes (depending on how you want it 

to display). You can type different text for each box.

3 Click Change Font to set the font size, style, color, and 

so on for your header, footer, or labels.

4 Click Insert Special Text to choose one of the 

following for your header, footer, or labels (only some of 

the choices are available for each):

5 When you’re finished designing your text, click OK. 

The text is previewed on your layout in the center of the 

screen.

Type here if you want your text centered 
under the picture or on the page. Otherwise, 
type it in the Left or Right box.
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Choosing Album Images

If you’re printing an album, Image Expert uses as many 

pages as necessary to print the entire album. If you don’t 

want to print all the images, you can choose the ones you 

want and position them in your layout. Follow these steps:

1 Click the Pick Images button . Your album appears 

in a “filmstrip” on the right side of your screen. 

2 Choose the images you want to print, and drag each one 

where you want it to appear in the layout. 

You may notice that some images are cropped. If you want to 

adjust the cropping, or zoom an image in or out, follow the 

instructions in the next section.

Adjusting the Printed Area

You can zoom in on an image, and then move it around to 

display just the portion you want. Follow these steps to 

adjust the printed area:

1 Double-click the image you want to adjust. 

album filmstrippage layout
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The other images fade out, and the sizing tools on the 

left side of the screen become active.

2 Click the Zoom In tool  and then click on an image 

to enlarge and crop it. 

You can also click the Zoom Out tool  to reduce 

your image and display more of it.

3 Click the Move tool  and then click on an image to 

move it and choose the portion you want to display. 

4 Click the Reset Size button  to return to the default 

size and layout.

5 When the preview shows the layout you want, you can 

click the Print button  to produce your printout.

Adding Sound to an Image

If your Windows system includes a microphone and a 16-bit 

sound card with speakers, you can add voice or musical 

annotations to your pictures. Follow these steps to add sound 

to a picture in Image Expert:

1 Select the image you want to add sound to.

2 Click the Record button  on the left side of your 

screen or select Record Audio from the Annotation 

menu to open the Record dialog box:

sizing 
tools
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3 Select the option you want:

◗ To add sound to an image, choose Record New.

◗ To add additional sound to an existing audio clip, 
choose Record Additional.

◗ To end your recording, choose Stop.

◗ To listen to your new recording, choose Play New.

◗ To listen to your original recording, choose Play 

Original.

4 If you like your new recording, click OK. Otherwise, 

click Undo to delete the new recording, then repeat 
step 3 to make a new recording. 

Playing Back Sounds

When you open an image that has audio attached to it 

(indicated by a music note), the audio clip automatically 

plays.

You can also select an image and use the buttons on the left 
side of the Image Expert window to listen to its audio clip:

indicates audio 
message

play or restart

pause

stop

record

edit
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Editing Sounds

You can use Image Expert to modify your recorded sounds 

by cutting or copying and pasting from one clip to another. 

Follow these steps:

1 Select an image that has an audio clip.

2 Click the Edit Audio button , or choose Edit Audio 

from the Annotation menu. The sound wave window 

opens:

3 Click and drag to select a section of the audio clip, or the 

entire clip. You can perform the following operations:

◗ Click the Play button to hear the section you 

selected.

◗ Select Cut from the Edit menu to remove it.

◗ Click Copy from the Edit menu to copy it.

◗ Select another image and click Paste from the Edit 

menu to add the sound clip to the new image.

NOTE

To adjust recording or playback volume or modify other features, 

select Audio Properties from the Annotation menu. You can also 

click the sound icon on your Windows taskbar. Use the volume 

control on your speakers to quickly adjust playback volume.

Deleting Sounds

To delete an audio clip, follow these steps:

1 Select the image with the sound you want to delete.

2 Select Delete from the Edit menu, or press the Delete 

key on your keyboard. The following message appears:
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3 Check the Only delete the audio box, then click Yes.

Displaying Albums as Slide Shows

When you display an Image Expert album as a slide show in 

Windows, you can have it play automatically with various 

transition effects between images. Follow these steps:

1 Open your album.

2 Click the Slide Show button  or select 

Slide Show from the View menu. 

The first image appears on your screen with the slide 

show controls:

3 Click the Play button  to see the slide show.

4 To change the look of your slide show, click the Options 

button . The Slide Show Options dialog box appears.

5 Set any of the following options and click OK:

◗ To stretch your pictures across the whole screen, 

click Fit to Screen.

◗ To change the display period for each picture, 

change the number in the Seconds Between 

Pictures box.

play
stop options

close

play audio
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◗ To play the slide show only once, click 

Continuous Repeat to deselect it.

◗ To hide the titles of your pictures, click Show 

Titles to deselect it.

◗ To turn off the fades and dissolves that play 

between pictures, click Show Transition Effects 

to deselect it.

◗ To turn off audio clips attached to your images, 

click Play Sounds to deselect it.

6 Click the Close button  to stop the slide show.

Using an Album as a Screen Saver

If you’re using Windows, it’s easy to make your own screen 

saver with your favorite pictures. Follow these steps:

1 Open the Image Expert album you want to use.

2 Choose Set Screen Saver from the File menu. Image 

Expert asks you to confirm your choice.

3 Click Yes.

Windows will play a slide show of your album whenever 

your system is idle.

NOTE

The screen saver slide show doesn’t include controls. If you want 

to change the way your pictures are displayed, you have to use 

the screen saver settings in your Control Panel. See your 

Windows documentation or Help system for more information.

Setting an Image as Wallpaper

If you’re using Windows, you can use one of your own 

pictures as your desktop background. Follow these steps:

1 Open or select your image in an Image Expert album.

2 Choose Set As Wallpaper from the File menu. 
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The following dialog box appears.

3 Choose Center to place your picture in the middle of 

the screen or Tile to fill the screen with copies of your 

picture.

4 If you want the image to be stretched across the whole 

screen, click Resize to fit screen.

5 Click Yes. (If you change your mind, click Remove 

Wallpaper.)

You can minimize Image Expert to see your new 

wallpaper.

Copying to Diskette or Zip Disk

If you’re using Windows, you can copy Image Expert albums 

or individual images to diskettes or Zip disks. You can also 

include a player, so your friends and business associates can 

view your pictures on their computers. This makes your 

images and albums completely portable. 

Follow these steps:

1 Insert a diskette into your diskette drive or a Zip disk 

into your Zip drive.

2 Open the Image Expert album you want to copy. 

If you don’t want to include all of your images, select the 

images you want to add. To select more than one image, 

hold down the Ctrl or Shift key.

3 Select Save To Floppy from the File menu. 

click to remove 
existing wallpaper
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You see the following dialog box:

4 Make sure your diskette drive or Zip drive letter appears 

in the Copy images to box.

5 To include a slide show player to view the pictures, 

make sure Include Slide Show Player is checked. 

6 If you want to copy the whole album, make sure there is 

no check mark next to Selected Images Only. 

NOTE

Make sure your diskette (or other storage device) is not 

write-protected before you try to copy.

7 Click OK to copy your files.

Viewing the Pictures on Diskette or Zip Disk

To run the slide show, double-click the player icon or 

player.exe file. The pictures appear on your screen with the 

slide show controls, as shown below:

See page 8-11 for instructions on setting slide show options.

Sending Pictures and Sound by 

E-mail

If you’re using Windows and your e-mail application 

complies with the MAPI (messaging application 

programming interface) standard, you can send a picture 

directly from Image Expert. For example, you can use Inbox 

or Microsoft Exchange. You need to set up Microsoft 

Exchange to work with your Internet service.

play
stop options

close

play audio
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NOTE

If you can’t e-mail pictures directly from Image Expert, you can 

always send an e-mail message as you do normally and attach 

one or more image and sound files.

Before you start, make sure your modem and Internet service 

are working correctly and your e-mail application is 

configured. Then follow these steps:

1 Open an album in Image Expert.

2 Select or open the image(s) you want to send. Some 

e-mail systems may limit the number of images you can 

send in a single message.

NOTE

If no images are selected, all images in the album will 

be sent.

3 Choose Send from the File menu. You see the Choose 

Profile dialog box.

4 Choose the profile you want to use. 

Click New if your Internet service has not been set up 

to work with Microsoft Exchange. For more 

information about setting up Microsoft Exchange, see 

your Windows documentation or help system.

5 Click OK. Your e-mail application opens, and the 

image(s) you selected appear as attachments.

6 Type the e-mail address where you’re sending the 

picture(s). You can also type in a subject heading and 

message if you want. 

7 When your e-mail is ready, click whatever button your 

application uses to send. The picture(s) are mailed. 

click to configure 
your Internet 
service for 
Microsoft 
Exchange
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Your e-mail application closes, and Image Expert 

becomes active again.
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9   

ou can edit your images to enhance their appearance, Ycrop, rotate, and resize them, or create special effects. 

This chapter describes the following Image Expert features:

◗ Viewing and selecting images

◗ Applying Quick Fix

◗ Correcting an image

◗ Cropping an image

◗ Resizing an image

◗ Rotating and flipping an image

◗ Applying special effects

◗ Changing the number of colors

Editing Images
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Viewing and Selecting Images

When your image is displayed in an album, you can rotate it 

or do a quick fix. However, to use any other editing features, 

you need to open the image by double-clicking it or selecting 

Open Image from the File menu.

Before you edit your image, you may want to use the Zoom 

and selection tools on the left side of your screen.

◗ Click Zoom, and then click anywhere on your image to 

enlarge your view. Right click or hold down the control 

key and click to zoom out.

◗ Use one of the three selection tools (Select Rectangle, 

Select Ellipse, Select Freehand) to isolate a part of 

your image before you edit it. Click the tool, then click 

and drag on your image to select the portion you want to 

work on. 

◗ Click Select All to select your entire image or all the 

images in an album.

◗ Click Select None to deselect your image or images.

NOTE

For more information about any of the editing tools described in 

this chapter, use the Help menu. 

Zoom

Select Rectangle

Select Ellipse

Select Freehand

Select All

Select None
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Applying Quick Fix

The easiest way to improve your image is to have Image 

Expert automatically “correct” it with the Quick Fix 

command. Follow these steps:

1 Double-click your image to open it in the Image Expert 

window.

2 Click the Quick Fix tool  or select Quick Fix from 

the Image menu.

If you don’t like the results, simply select Undo Quick Fix 

from the Edit menu. 

NOTE

If you Quick Fix an image displayed in an album (without opening 

it in the Image Expert window), you can’t undo it.

Correcting an Image

To fine-tune an image, follow these steps:

1 Double-click your image to open it.

2 Click the Corrections tool  or choose Corrections 

from the Image menu. You see a window like the 

following:

click and drag to adjust the 
division between the original 
and edited preview
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3 Click the tabs at the top of the screen to make these 

kinds of corrections:

◗ Contrast and Brightness

For adjusting the amount of light in your image and 

the difference between light and dark areas.

◗ Color

For correcting color casts and adjusting the balance 

of cyan (blue), magenta (red), and yellow; and red, 

green, and blue in your picture.

◗ Hue/Saturation

For adjusting colors around the “color wheel,” the 

strength or purity of color, and the brightness of 

your image.

◗ Sharpness

For emphasizing or de-emphasizing edges and 

details.

◗ Equalization

For increasing and brightening detail in dark areas 

of your image.

Each dialog box tab includes sliders for quickly and 

easily correcting your image. Simply move the slide 

indicator left or right to make your edit.

The preview window shows your image with the 

original view on the left and the corrected image on the 

right. If you want to adjust the division between the 

original and edited image, click and drag the triangle 

below the image. You can also zoom in on your image 

to see more detail. 

4 Do one of the following:

◗ Click Apply to make your changes on the current 

tab. Your edited image becomes your new original 

and the slide indicators move to the center of the 

range. 

◗ Click OK to save the changes you made on all the 

Corrections tabs and return to the main screen. 

◗ Click Cancel to cancel the changes on the current 

tab and return to the main screen.
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Cropping an Image

If you want to save only part of your image, use the crop 

function to cut out the rest of the image. Follow these steps:

1 Double-click your image to open it in the Image Expert 

window.

2 Click one of the selection tools.

3 Click and drag the mouse over the area you want to save. 

A dashed border indicates the area you selected.

4 If you change your mind about which part of the image 

to crop, simply click anywhere outside the selected area 

of the image and repeat step 3.

5 Click the Crop tool  or choose Crop from the Image 

menu. The part of the image that was outside the dashed 

line disappears.

Resizing an Image

You can resize your image by changing the number of pixels. 

This lets you maintain the image’s original resolution or 

pixels per inch. 

1 Double-click your image to open it in the Image Expert 

window.

selected area
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2 Choose Resize from the Image menu. You see a dialog 

box like the following:

3 Type a new number for the width or height. 

To maintain your image’s proportions, both numbers 

change together. If you want to distort your image, click 

Preserve Aspect Ratio to deselect it.

Rotating an Image

You can click the Rotate tool  to quickly rotate a picture 

to the right. For more options, open the image you want to 

change and select Rotate from the Image menu. 

NOTE

If you rotate an image displayed in an album (without opening it in 

the Image Expert window), you can’t undo it.

You can choose one of the following:

◗ Left (90 degrees counterclockwise)

◗ Right (90 degrees clockwise)

◗ Exact (specify the degree of rotation)

◗ Free (interactive rotation, as described below)

this box 
changes size 
to reflect the 
numbers you 
enter
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If you want to experiment with rotation, choose Free and 

follow these steps: 

1 Click on your image and hold down the mouse. Your 

pointer turns into the rotation tool. 

A rectangular outline of your image and an arrow 

appear, as shown:

2 Move the pointer to rotate your image. 

3 Release the mouse when your picture is at the angle you 

want. 

Flipping an Image

You can reverse your image by following these steps:

1 Double-click your image to open it in the Image Expert 

window.

2 Do one of the following:

◗ Select Flip Horizontal from the Image menu. 

(This is useful for printing T-shirt transfers.)

◗ Select Flip Vertical to turn your image upside 

down.
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Applying Special Effects

To transform or distort your images in interesting ways, 

follow these steps:

1 Open your image in the Image Expert window, then 

choose Effects from the Image menu. You see a dialog 

box like the following:

2 Click the tabs at the top of the screen to add these 

effects:

◗ Ripples

For an underwater effect. You can create whirlpool 

effects or just a slight distortion.

◗ Glass blocks

You can change the number and size of the blocks.

◗ Edges

To sharpen edges. You can also blend the image 

into a light or dark background. 

◗ Fisheye

To distort the center of the image, as if looking 

through a glass ball.

◗ Invert

To create a negative of your image, or to “solarize” 

it.
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Each dialog box tab includes sliders for applying the 

effect. Slide the indicator to the right to increase the 

distortion. You can combine several filters for even more 

unusual effects.

The preview window shows your image with the original 

view on the left and the distorted image on the right. 

If you want to adjust the division between the original 

and filtered image, click and drag the triangle below 

the image. You can also zoom in on your image to see 

more detail. 

3 Do one of the following:

◗ Click Apply to make your changes on the current 

tab. Your distorted image becomes your new 

original and the slide indicators move to the center 

of the range. 

◗ Click OK to save the changes you made on all the 

Effects tabs and return to the main workspace. 

◗ Click Cancel to cancel the changes on the current 

tab and return to the main workspace.

Changing the Number of Colors

To convert the color format of your image, open it and select 

Number of Colors from the Image menu. You can choose 

from the following:

◗ 24 Bit (Millions of Colors) 

The way your images are originally captured.

◗ 8 Bit (256 Colors)

For low-resolution display systems or certain types of 

software. 

◗ Grayscale (256 Shades of Gray)

For printing in black and white.

If you save your image as 8 Bit or Grayscale, you cannot 

switch back to 24 Bit color.

NOTE

Unlike the other editing options, changing the number of colors 

applies to the whole image. You can’t change the number of 

colors for a selected area only. 
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.

hen the camera is connected to your computer, Wyou can take pictures with a live preview on your 

computer screen to help you frame each shot. You can also 

set the camera’s clock and adjust a number of other settings 

from your computer.

This chapter covers the following:

◗ Taking pictures from your computer

◗ Adjusting camera settings from your computer

NOTE

You can use either Image Expert or EPSON Photo!3 to take 

pictures from your computer, adjust camera settings, and transfer 

images. PhotoPC 800 allows you to choose the application that 

best meets your needs and preferences.

10   

Taking Pictures From Your Computer 

With Image Expert

When you connect the camera and take pictures from your 

computer, you see a live preview of each shot before you 

capture it. You can control camera settings from your 

computer, and even set the shutter speed.

NOTE

If you have the optional AC adapter, you can save on batteries by 

using it when you connect the camera to your computer. The AC 

adapter should be available where you bought your PhotoPC 800, 

or you can order it from EPSON Accessories. See page A-2 for 

more information.

Operating the Camera From Your 

Computer
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Follow these steps to take pictures from your computer:

1 Connect the camera to your computer as described in 

Chapter 6. 

2 Position the camera facing the subject. Using a tripod 

will give you the most control when setting up your 

shots. See page A-4 for instructions.

3 Turn on your computer, then turn the camera dial to 

either  or . Open the camera lens.

4 Start Image Expert as described on page 6-5.

5 If necessary, close the Quick Tour and the Image Expert 

tip screen.

6 Click the Camera Controls button  or choose 

Controls from the Camera menu. 

You see a dialog box like the following:

7 Click Continuous Update to activate the live preview 

feature. The image you see is updated every 8 to 10 

seconds, depending on your connection speed. You may 

need to move the camera or your subject until you see 

the image you want to capture.

The colors in your live preview image may appear pale 

and washed-out. This will not affect the colors in your 

actual photograph.

click to erase 
images in the 
camera

click to 
capture the 
image you 
see
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You can click the Flash and Resolution buttons on the 

screen to adjust these settings just as you would by using 

the buttons on the camera. For more information about 

the flash and resolution (image quality) settings, see 

Chapter 3. 

NOTE

When the camera is connected to your computer, you can’t 

use any of the control buttons or the shutter button on the 

camera. You can operate these features only through your 

computer.

8 When your shot is ready, click Take Picture. The 

image is captured and processed. 

9 Click Close when you’re finished taking pictures from 

your computer. 

NOTE

The live preview feature quickly drains your batteries. Make sure 

you turn it off as soon as you’re finished, or use the optional AC 

adapter.

Using the Self Timer

You can use this feature to have your computer take a picture 

automatically, after a delay period that you can set. This 

allows you to take self-portraits and other specialized shots.

Follow these steps: 

1 Click Self Timer. You see the following dialog box:

2 Enter a number for the delay period you want to use. 

You can set up to a 120-second delay.

3 Click Start/Stop to start the countdown and take the 

picture. The red timer light on the camera remains on 

for the delay period you entered. Then the light flashes 

rapidly for 2 seconds and the shutter is released.

The camera beeps and processes your picture.
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Taking Pictures With EPSON Photo!3

You can use your EPSON Photo!3 application to take 

pictures from your computer, in the same way as Image 

Expert. 

1 Connect the camera to your computer as described in 

Chapter 6, and then position the camera facing the 

subject. 

NOTE

Using a tripod will give you more control when setting up 

your shots. (See page A-4 for instructions on using a tripod.)

2 Turn on both your camera and your computer, then 

open the camera lens. Make sure the camera dial is set 

to  or .

3 Start EPSON Photo!3. (Click Start, and then point to 

Programs, EPSON Photo!3 Ver.1, EPSON 

Photo!3 Ver 1.)

4 Click the Controls tab. You see a dialog box like the 

following:

5 Click Start to display the live preview.

The colors in your live preview image may appear pale 

and washed-out. This will not affect the colors in your 

actual photograph.
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You can use the Mode, Flash, Self Timer, and 

Macro controls on the screen to adjust these settings 

just as you would by using the buttons or LCD menus 

on the camera. (For information about using the 

camera’s buttons, see Chapter 3. For information about 

using the LCD menus, see Chapter 4.)

6 When your shot is ready, click Take a Picture. The 

image is captured and processed. 

7 Click Close when you’re finished taking pictures from 

your computer. 

The Auto-Stop Timer shuts off the live preview after one 

minute to save battery power. You can set the timer from 

30 seconds to 5 minutes. 

Adjusting Camera Settings From 

Your Computer

You can use either Image Expert or EPSON Photo!3 to 

change the following camera settings:

◗ Time

◗ Date

◗ Power down time (Image Expert only)

◗ Camera ID 

◗ Connection Port

◗ Connection Speed

Changing Settings With Image Expert

You can change settings in Image Expert while you’re 

viewing pictures in the camera. Follow these steps:

1 Connect the camera to your computer as described in 

Chapter 6. 

2 Turn the camera dial to , then turn on your computer 

system.
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3 Start Image Expert, then select Properties from the 

Camera menu. The Camera Properties menu appears:

◗ Enter a new Description of the camera to change 

the default. This might be useful if you have more 

than one camera and you want to record its 

description in your picture data.

◗ Type in the Camera Time box to change the time 

and date. Or, click Set Camera to Computer 

Time to automatically synchronize your camera to 

your computer.

4 Click OK to save your settings and exit the Camera 

Properties dialog box.

5 If you want to adjust your port settings, select 

Connection from the Camera menu. You see the 

Connection dialog box: 

◗ If necessary, select a new source. The standard 

selection is Serial/USB. If you’re using a PCMCIA 

adapter to access a PC card slot, select PC Card in 

the Connect Via drop-down list. (FlashPath is 

not implemented on the PhotoPC 800.)
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◗ Select another port if you want to change your 

connection. In most cases, it’s best to leave the Port 

setting at Auto because Image Expert can detect the 

camera connection automatically. 

◗ Select a different communication speed. Image 

Expert automatically chooses the fastest speed that 

works with your system. This may actually be too 

fast for the configuration of your port. You may 

need to experiment to choose the best speed. (See 

your Windows documentation or help system to 

change the port speed for your computer.)

6 Click OK to save your settings and exit the Connection 

dialog box.

Changing Settings With EPSON Photo!3

You can also change settings in EPSON Photo!3 while you’re 

viewing pictures in the camera. Follow these steps:

1 Connect the camera to your computer as described in 

Chapter 6. 

2 Turn the camera dial to , then turn on your computer 

system.

3 Start EPSON Photo!3, then click the Setup tab to 

display the following dialog box:
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4 Change any of the following Computer Connection 

settings:

◗ Select another port if you want to change your 

connection. In most cases, it’s best to leave the Port 

setting at Auto because EPSON Photo!3 can detect 

the camera connection automatically. 

◗ Select a different communication speed. EPSON 

Photo!3 automatically chooses the fastest speed that 

works with your system. This may actually be too 

fast for the configuration of your port. You may 

need to experiment to choose the best speed.

5 Click Test Connection to make sure your new settings 

work with your system.

6 Click the Set Time button to change the camera’s time 

and date settings. 

You see a dialog box like the following:

Enter new values for the settings, or click Copy from 

Computer to have your camera automatically 

synchronized to your computer. Click OK to return to 

the Setup dialog box.

7 Enter a new Camera ID if you want to change the 

default. This might be useful if you have more than one 

camera and you want to be able to have its ID recorded 

in your picture data.
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ou can connect your camera to a multimedia projector Yor television and show not just photos, but also text and 

graphics. The EPSON Photo File Uploader3 lets you 

transfer images from your computer to your camera’s 

memory card. Anything you can display on your computer 

screen can be captured, converted, and uploaded. You can 

create and show a presentation without printing overhead 

transparencies or slides, and without a laptop computer.

This chapter explains the following:

◗ Uploading images to the camera’s memory card

◗ Converting presentations

◗ Projecting your presentation

11   

Uploading Images to the Camera 

The EPSON Photo File Uploader3 software allows you to 

convert any image or presentation slide to the EPSON Photo 

file format and upload it to your CompactFlash memory 

card. 

You can upload images in 640 × 480 pixel, 1600 × 600 pixel, 

or 1600 × 1200 pixel sizes. EPSON Photo File Uploader3 

automatically converts images from their original size to 

whichever of these sizes you choose.

NOTE

Images that have been cropped will display black strips in the 

areas that have been cropped out.

Using Your Camera for Presentations
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Uploading Images From Your Windows PC

Before you start, make sure the camera is connected to your 

computer, the computer is on, and the camera dial is turned 

to . Then follow these steps:

1 Start the EPSON Photo File Uploader3 program. Click 

Start, point to Programs, EPSON PhotoFile 

Uploader3, then click EPSON Photo File 

Uploader3. You see a screen like the one on the right.

NOTE

Only one application at a time can access the camera. Make 

sure neither EPSON Photo!3 nor Image Expert are running.

2 Use the Drive and Folder lists to locate the folder 

containing the images you want to upload. Double-click 

the folder to select it.

The images in the folder are listed in the File Name 

box.

NOTE

If you want to upload images from a network drive, you may 

need to map the drive before opening the EPSON Photo File 

Uploader3 software. See your Windows documentation for 

more information.

check this box for helpful information
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3 Select the format of the images you want to upload from 

the File Type list. 

4 Select the images you want to upload in the File Name 

list. Then click the –> button. If you want to upload all 

the images in the list at once, click the >> button.

As you select files, they appear in the Selected Files 

List in the order they will be uploaded. This determines 

the sequence in which you can display the images. 

◗ To rearrange the uploading (and display) order, 

select the image you want to reorder, then click the 

↑ or ↓ sort arrow.

◗ If you want to change your selection, click the <– 

button to remove selected files or click the << 

button to remove all the files from the Selected 

Files List.

◗ If you want to preview a selected image and confirm 

its size, click the Preview checkbox. 

5 For each file in the Selected Files List, choose an 

image size from the Image Size box. The File Uploader 

resizes your files during the transfer process.

If you want to save copies of the converted files on your 

computer, click the Save file to checkbox. Click 

Browse, then select the folder where you want to save 

the files. Click OK. The folder you selected is displayed 

to the right of the Browse button.

size of 
previewed 
image in 
pixels
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6 Click the Start button to start uploading the images. 

EPSON Photo!3 opens and displays the images you 

selected:

Depending on the number of images, you may have to 

wait a minute or so for EPSON Photo!3 to open.

7 Click Select All to select all the images, or select 

individual images by clicking the thumbnails in the 

image selection window.

8 Click Upload/Copy. 

The Upload/Copy Photos dialog box appears:

9 Click Upload into the Camera to upload the images 

to your camera’s memory card, or click Copy to a 

Memory Card in a drive to upload to a memory card 

installed in your computer’s PCMCIA drive; then click 

OK.

The images are uploaded to the destination you selected. 

If you clicked the Save file to checkbox in step 5, the 

converted images are also saved to the folder you 

specified.
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Uploading Images From Your Macintosh

Follow these steps to upload images to your camera from 

your Macintosh:

1 Make sure the camera is connected to the computer, that 

the computer is turned on, and the camera dial is turned 

to .

2 Double-click the EPSON Photo File Uploader 3 icon 

in the EPSON Photo File Uploader folder. The 

EPSON Photo File Uploader3 dialog box opens, as 

shown on the right.

NOTE

Only one application at a time can access the camera. Make 

sure neither EPSON Photo!3 nor Image Expert are running.

3 Click Add. The Select Files dialog box appears. 

4 Double-click the folder containing the images you want 

to upload, then select each file you want to upload and 

click Select.

If you want to preview a selected image and confirm its 

size, click the Preview checkbox. It takes a few seconds 

longer to select images with previews displayed.

check here for helpful information
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5 When you finish selecting image files, click Done to 

close the Select Files dialog box. The selected images 

appear in the Selected File List in the order they will 

be uploaded. This determines the sequence in which you 

can display the images. 

◗ To rearrange the uploading order, select the image 

you want to reorder, then click Up or Down.

◗ To remove files from this list, select the file(s) and 

click Remove.

6 For each file in the Selected File List, select an image 

size from the Image Size box. The File Uploader will 

resize your files during the transfer process. 

If you want to save copies of the converted files on your 

computer, click the Save file to checkbox before 

uploading the photos. Click Browse to open the Select 

Folder dialog box, then select the folder where you want 

to save the files. Click Select: to close the Select Folder 

dialog box. The folder you selected is displayed to the 

right of the Browse button.

7 Click Upload. A window opens to show you the 

progress of the file conversion. Then EPSON Photo!3 

opens and displays the images you selected:

8 Click Select All to select all the images, or select 

individual images by clicking the thumbnails in the 

image selection window. 
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9 Click Upload. The Upload/Copy Photos dialog box 

appears. 

10 Click Upload into the Camera to upload the images 

to your camera, or click Copy to a Memory Card in a 

drive to upload to a memory card installed in the 

PCMCIA drive of your Macintosh; then click OK. The 

images are uploaded to the destination you selected.

If you clicked Save file to in step 6, the converted 

images are also saved to the folder you specified.

11 Click Close to exit EPSON Photo!3.

Converting Presentations

If you want to upload a presentation or document that is not 

saved as a standard image file, you can make a “screen 

capture” of your computer desktop with the file open. This 

lets you turn any document or presentation into a series of 

image files that you can convert and upload to your camera’s 

memory card.

NOTE

If you want to upload a PowerPoint presentation, you don’t need 

to use this conversion procedure. You can save the slides as JPG 

files in PowerPoint, and then upload them into the camera. 

Choose Save As from the PowerPoint File menu and choose 

JPEG File Interchange Format as the file type.

Windows users can make screen captures from within the 

EPSON Photo File Uploader3 utility; Macintosh users need 

to use the standard Macintosh screen capture function.
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Capturing Windows Screens

Before you start, make sure the camera is connected to your 

computer, the computer is turned on, and the camera dial is 

turned to . Then follow these steps:

1 Start the EPSON Photo File Uploader3 program. Click 

Start, point to Programs, EPSON Photo File 

Uploader3 Ver.1, then click EPSON Photo File 

Uploader3. You see the EPSON Photo File Uploader3 

window.

NOTE

Only one application at a time can access the camera. Make 

sure neither EPSON Photo!3 nor Image Expert is running.

2 Click the Screen Capture tab. The Screen Capture 

dialog box appears, as shown on the right.

3 Use the Drive and Folder lists to select the folder where 

you want to save the screen capture. To create a new 

folder for the images, click the New Folder button.

4 Specify the key combination you want to use for screen 

captures in the Hot Key setting box. Click the ALT, 

CTRL, or SHIFT checkbox, then select a function key 

from the hot key list. The default hot key is F5.

choose the key combination to use for capturing screens

set the drive and folder for saving screen captures
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5 Click Start to activate the key combination. When the 

key combination is activated, the Start button changes 

to a Stop button. The key combination remains active 

only for the current session. To deactivate the hot key 

combination, press the Stop button.

6 Start your application and open the file to the page or 

image you want to capture.

NOTE

The entire screen is captured, not just the active window. 

Make sure you maximize your presentation before you 

capture it. If you set your application to “slide show” mode 

(or the equivalent) you can capture just the image you want, 

without menus and other screen elements.

7 Press the hot key combination you selected. 

Your screen capture is assigned a file name and saved to 

the folder that you specified.

You can make as many screen captures as you’d like; 

simply open each file you want to capture and press your 

screen capture key combination again.

8 When you’re finished, close your application and click 

the Stop button on the Screen Capture dialog box. The 

key combination you selected is erased.

If you want to upload your screen captures to the camera’s 

memory card right away, click the Upload To Camera tab. 

The screen capture files appear in the File Name list. Then 

follow the uploading instructions starting with step 4 on 

page 11-3.

TIP

Presentations using large fonts (at least 18 point) work best.

Capturing Macintosh Screens

EPSON Photo File Uploader3 for the Macintosh does not 

have a screen capture feature. However, you can make screen 

captures using your Macintosh system software, then use 

EPSON Photo File Uploader3 to upload the screen captures 

to your camera’s memory card.

The procedure may differ slightly, depending on your 

Macintosh. See your computer manual for more 

information.
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Make sure the camera is connected to your Macintosh, the 

computer is turned on, and the camera dial is turned to . 

Then follow these steps:

1 Start EPSON Photo File Uploader3. Double-click the 

EPSON Photo File Uploader 3 icon in the EPSON 

Photo File Uploader folder. The EPSON Photo File 

Uploader3 dialog box appears.

2 Start your application and open the file for the image 

you want to capture.

3 Press the Command, Shift, and 3 keys on your 

computer keyboard at the same time. Your Macintosh 

names and saves the screen shot on your hard drive (not 

in a folder).

You can make as many screen shots as you’d like; simply 

repeat this step.

NOTE

◗ If you’re running OS 8.0 or later, you can capture just the 

active window. Press the Command, Shift, and 4 keys at 

the same time, then click the window you want to capture, 

or drag the cursor around that portion of the screen you want 

to capture.

◗ If you’re running OS 7.5x, the entire desktop is captured, not 

just the active window. Make sure you make your document 

window as large as possible before you capture it. If you set 

your application to “slide show” mode (or the equivalent), 

you can capture just the image you want, without menus 

and other screen elements.

4 When you’re finished, close your application.

To upload your screen shots to the camera, click the EPSON 

Photo File Uploader3 window to make it active, then follow 

the uploading instructions starting with step 3 on page 11-5. 
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Projecting Your Presentation

You can display the uploaded images on a multimedia 

projector, television, or other video output device. Use the 

video cable that came with your PhotoPC 800. 

NOTE

Using the optional AC adapter is highly recommended when you 

project your presentation. See page A-2 for instructions and 

ordering information.

Follow these steps:

1 Make sure your camera and TV or video projector are 

turned off.

2 Open the camera’s connector cover and connect the 

black end of the video cable to the Video Out port, as 

shown below: 
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3 Connect the yellow end of the video cable to the 

VIDEO IN port on the TV or projector.

4 Turn on the TV or video projector and switch it to 

video mode.

5 Turn the camera dial to .

The last image that you uploaded to the camera is projected. 

If you are using the optional AC adapter, you can also see the 

image on the LCD screen.

You can use the camera’s slide show feature to play your 

images automatically, or play them one at time using the 

navigation buttons. You can use all of the camera’s other 

playback features to show your presentation.
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our PhotoPC 800 camera lets you print yourYpictures directly to any of several EPSON Stylus® color 

ink jet printers, without using a computer. You can choose 

from a number of layout options, select the type and size of 

the paper you want to use, and print using optional filters 

and print modes. You can print directly from the camera to 

any of the following printers:

◗ EPSON Stylus Photo

◗ EPSON Stylus Photo 700

◗ EPSON Stylus Photo EX

◗ EPSON Stylus Photo 750

◗ EPSON Stylus Photo 1200

◗ EPSON Stylus COLOR 740

12   

NOTE

Using the optional AC adapter is highly recommended when 

you’re printing from the camera. The adapter should be available 

where you bought your camera. Or, see the Introduction for 

information on ordering an adapter from EPSON Accessories.

This chapter includes the following information about using 

the Direct Print program, which comes preinstalled in your 

camera:

◗ Connecting the camera to the printer

◗ Starting Direct Print

◗ Printing

◗ Removing and reinstalling the Direct Print program

◗ Reading error and status messages

Printing Directly From the Camera
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NOTE

The Direct Print program is designed to print on special ink jet 

media, including Photo Quality Ink Jet paper or cards, glossy film, 

Photo Paper, and photo stickers. If you use plain paper, your 

pictures will not print with the highest quality. See your printer 

user’s guide for information on special ink jet media available 

from EPSON.

Connecting the Camera to the 

Printer 

Before you start, make sure you have the Macintosh/Direct 

Print serial cable that came with your camera. Then follow 

these steps to connect your camera to the printer:

1 Make sure both the camera and printer are turned off.

2 Connect the round end of the serial cable to the serial 

connector on the back of the printer. Make sure the 

arrow on the connector faces up.

3 Open the connector cover on the side of the camera.
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4 Align the connector on the square end of the serial cable 

and the camera’s serial port. Then insert the connector.

Starting Direct Print 

Follow these steps to start Direct Print:

1 Make sure the printer is turned off.

2 If you have the optional AC adapter, connect it to the 

camera to save battery power (see page A-2 ).

3 Turn the camera’s dial to .

4 DirectPrint appears on the LCD screen. Press the top 

button (next to DirectPrint).

You see the Direct Print main menu:

Follow the steps in the next section to print different types of 

projects.

NOTE

You can press the MENU button to return to the previous screen 

while using Direct Print.
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Printing

You can print any selected image(s) or all the images in your 

camera on various types of paper. You can print full size 

images, sticker sheets with multiple copies of the same image, 

and greeting cards. You can even create an album of your 

images with descriptive text next to each photo. The Direct 

Print main menu offers these choices:

The following sections explain how you use these print 

formats to set up and print different types of projects.

Printing Single and Multiple Images

The Print and Print All formats let you print both single 

and multiple images on a page. These formats allow the 

greatest variety of options. You can print on different paper 

sizes with an assortment of layouts, and you can use any of 

the available filters, paper types, or print modes. The 

following table shows the way the printout appears for 

different paper sizes.
Print format Description

Print All Prints all the images stored on the memory card. You can 
print more than one copy of selected images.

Print Lets you select the image(s) you want to print. You can 
print more than one copy of selected images.

Index Prints a small thumbnail image of every picture on your 
memory card on contact sheets. 

Album Lets you print an album of selected pictures, with up to 
three different images on one sheet of paper. You can 
print one copy of each image.

Sticker Prints 16 small or 4 larger copies of the selected image 
on sheets of EPSON Photo Stickers.

Layout 
options

Paper Size options

Letter A6 A3 A4

3.5 × 5 —

5 × 7 — —

6.5 × 8.5 —

8 × 10 — — —

10 × 12 — — —

A

A

A

A
A

A

A

A

A

A A

A
A

A A

A

A
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Load your paper in the printer following the instructions in 

your printer user’s guide, then follow these steps:

1 On the Direct Print main menu (shown on page 12-3), 

select your print format. If you want to print all the 

images on your memory card, press the top button (next 

to Print All). If you want to print selected images, press 

the + button (next to Print). You see a screen similar to 

the following:

2 Select your Paper Size and Layout settings by pressing 

the button next to the setting. For example, to select 

Letter as the Paper Size setting, press the button next to 

Paper Size (the top button) until you see Letter 

displayed beneath the setting. 

NOTE

The Paper Size and Layout settings are linked, so sometimes 

you’ll see the Layout setting change as you cycle through 

the available Paper Size options.

3 Press the W.B. button (below the down arrow) if you 

want to change the Information or Filter settings. You 

see a screen similar to the following:

Press the top button (next to Information) to change 

the Information setting. When the Information setting 

is On, your pictures print with the date and time they 

were taken.
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Press the + button (next to Filter) to cycle through the 

filter choices if you want to modify the color of your 

printout. You can choose Monochrome to print your 

images in black and white, Blue to print them in blue 

tones, or Sepia to print them in brown tones for an 

old-fashioned look. If you select None, your color 

images print in color and your black and white images 

print in black and white.

4 When you’re done making changes to the Information 

and Filter settings, press the W.B. button again to return 

to the previous screen.

5 If you want to select specific images (or print more than 

one copy of some images), press the bottom button 

(next to Photo Selection). You see thumbnail images 

of the first nine photos in the camera’s memory card, 

with the currently selected image framed in white.

NOTE

You don’t have to select images if you’re using the Print All 

format. However, you can choose to print more than one 

copy of some images.
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6 To select a different picture, press the ISO button 

(below the left arrow) or the W.B. button (below the 

right arrow) to move the selection frame backward or 

forward through your pictures.

7 Now select the number of copies of your picture that 

you want to print. Press the + button (next to the up 

arrow) or the − button (next to the down arrow) to 

increase or decrease the number of copies. A checkmark 

appears on your selected photo. (If you select 0 copies, 

the checkmark disappears.)

8 If you want to rotate your picture 90 degrees in either 

direction for printing, press the button next to Rotation 

(the bottom button). An orientation icon appears on the 

thumbnail image:  to rotate clockwise 90 degrees, or 

 to rotate counterclockwise 90 degrees. Press the 

button to cycle through the rotation options or turn off 

rotation.

NOTE

Rotation is only available for Letter, A6, A4 and A3 Paper 

Size settings.

9 When you’re finished selecting your picture(s), press the 

MENU button (beneath BACK). You see a 

confirmation of your selection. If your selection is 

correct, press the bottom button (next to Done).

If you need to change your selection(s), press the top 

button (next to Cancel) and repeat steps 5 through 9.
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Producing Your Printout

Before you print, you’ll need to make a few more Direct 

Print settings. Follow these steps:

1 Press the ISO button (beneath Print). The current print 

settings appear on the screen (your settings may vary).

2 Press the + button (opposite Paper Type) to cycle 

through the Paper Type settings and select the type of 

paper or film you loaded in the printer. (The Paper Size 

setting you previously selected is displayed beneath this 

setting.)

3 Press the bottom button (next to Print Mode) to select 

either Normal, Fine, or Fast printing mode. Fine 

print mode produces a higher-resolution, slower 

printout. Fast print mode produces a quicker, lower-

resolution printout.

4 If you need to adjust the printing position of your paper, 

press the top button (next to Adjust). You see an 

adjustment screen like this one.

5 Press the + button (next to the up arrow) or the − 
button (next to the down arrow) to adjust the vertical 

position. Press the ISO button (under the left arrow) or 

the W.B. button (under the right arrow) to adjust the 
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horizontal printing position. The position moves 

0.2 mm each time you press a button, and the current 

adjustment distance is displayed on the screen.

6 When you’re finished, press the MENU button (beneath 

BACK) to return to the print settings menu.

7 Press the ISO button (beneath Print) to begin printing. 

You see a confirmation message, then the LCD screen 

goes blank. The status light begins blinking and the star 

icons march across the status display panel on top of the 

camera. Depending on the Print Mode option you 

selected, it may take a moment for your printer to begin 

printing.

If you see an error message while printing, see page 

12-17 for instructions.

NOTE

If you need to cancel printing, hold down the MENU button. 

The status light turns red and a cancellation message 

appears briefly on the LCD screen. You see the print settings 

screen again. Repeat this step to resend your print job.

8 When you finish printing, the print settings screen 

reappears on the camera’s LCD screen. Press the MENU 

button (beneath Back) several times to exit Direct Print. 

Then turn the camera dial to Off and turn off the 

printer.
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Printing a Card

You also use the Print format to print cards. EPSON Photo 

Quality Ink Jet cards are perfect for snapshots, photo 

postcards, and many other uses. The following table shows 

the available paper sizes and layouts for your cards.

Follow these steps:

1 On the Direct Print main menu (shown on page 12-3), 

press the + button (next to Print) to select your print 

format. You see a screen similar to the following:

2 Select your Paper Size and Layout settings by pressing 

the button next to the setting. Available paper sizes for 

cards are A6 and PhotoCard. (If your Paper Size is set 

to PhotoCard, the Layout is automatically set to 

PhotoCard.)

Layout 
options

Paper Size options

Letter A6 A3 A4 PhotoCard

Card Top — — — —

Card 
Middle

— — — —

Card 
Bottom

— — — —

PhotoCard — — — —

A

A

A

A
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3 Press the W.B. button (below the down arrow) if you 

want to change the Information or Filter settings. (See 

page 12-5.) When you’re done, press the W.B. button 

again to return to the previous screen.

4 Press the bottom button (next to Photo Selection) to 

select your image. Select a single image for your card. If 

your Paper Size setting is A6, you can rotate your image. 

(See page 12-7.) 

5 When you’re ready to print your card, follow the steps 

on page 12-8.

Printing Album Images

The Album print format lets you print an “album” of 

selected images on Letter or A4-size paper. Up to three 

images are lined up on the left side of the page. If the 

Information setting is On, descriptive information about 

each image is automatically added on the right. The 

following table lists Layout and Paper Size options, and 

shows the way your printouts appear:

Layout 
options

Paper Size options

Album

Letter or A4

A

A
A

A

A

A

A

A

A
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Load your paper in the printer, then follow these steps to 

print album images:

1 On the Direct Print main menu (shown on page 12-3), 

press the bottom button (next to Album) to select your 

print format. You see a screen similar to the following 

(the Paper Size setting defaults to A4 or Letter):

2 Select your Paper Size setting by pressing the button 

next to the setting. (The Layout setting is automatically 

set to Album.)

3 Press the W.B. button (below the down arrow) if you 

want to change the Information or Filter settings. (See 

page 12-5.) When you’re done, press the W.B. button 

again to return to the previous screen.

4 Press the bottom button (next to Photo Selection) to 

select your images. (See page 12-6.) 

5 When you’re ready to print your album, follow the steps 

under “Producing Your Printout” on page 12-8.
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Printing Stickers

When your print format is set to Sticker, you can print 16 

small or four larger copies of a single image on sheets of 

EPSON Photo Stickers. You can select the following Paper 

Size and Layout settings:

NOTE

You can order EPSON Photo Stickers (product code S041144) 

from EPSON Accessories at (800) 873-7766.

Load your photo sticker sheets in the printer, following the 

instructions that came with the stickers. Then follow these 

steps:

1 On the Direct Print main menu (shown on page 12-3), 

press the W.B. button (under Sticker) to select your 

print format. You see a screen similar to the following 

(your Paper Size setting defaults to either Stickers 16 

or Stickers 4):

2 Select your Paper Size setting by pressing the top button 

(next to Paper Size). The Paper Size and Layout 

settings are linked, so the Layout setting automatically 

changes.

Layout 
options

Paper Size options

Stickers 4 Stickers 16

1 photo × 4
2 photos × 2

—

1 photo × 16
2 photos × 8 —

A A

A A
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NOTE

You can’t turn Information On or select a filter when the 

print format is set to Sticker.

3 Press the bottom button (next to Photo Selection) to 

select the image you want to print on your stickers. You 

see thumbnail images of the first nine photos on the 

camera’s memory card, with the currently selected image 

framed in white.

4 To select a different picture, press the ISO button 

(beneath the left arrow) or the W.B. button (beneath the 

right arrow) to move the selection frame backward or 

forward through your pictures.

5 When you’ve selected your image, press the + button 

(next to the up arrow) to select 1 Copy. (You can’t 

rotate the image.) Then press the MENU button (under 

BACK). You see a confirmation of your selection.

6 If your selection is correct, press the bottom button 

(next to Done). If you need to change your selection, 

press the top button (next to Cancel) and repeat steps 4 

through 5.

7 When you’re ready to print your stickers, follow the 

steps on page 12-8. You may want to make a test print 

to make sure your pictures are aligned properly. Then 

you can use the Adjust setting to align them for your 

final printout. 

NOTE

The Paper Type setting is automatically set to Glossy Film 

and you can choose only Fine or Normal print modes.

Altair.book  Page 14  Thursday, July 1, 1999  3:33 PM



Printing Directly From the Camera  12-15

A

B
12

Printing an Index of Your Images

The Index print format lets you print a contact sheet with 

thumbnail images of all the images on your memory card. 

The following table shows how your printout will look:

Follow these steps to print an index of all your images:

1 On the Direct Print main menu (shown on page 12-3), 

press the − button (next to Index) to select your print 

format. You see a screen similar to the following (your 

Paper Size setting will be different):

2 Select your Paper Size setting by pressing the top button 

(next to Paper Size). You can choose Letter, A6, or 

A4. The Layout setting is automatically set to Index.

Layout 
options

Paper Size options

Index

Letter or A4 A6
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3 If you want to print information for each image, press 

the W.B. button (under the down arrow) to go to the 

following menu. Then press the top button (next to 

Information) to turn it On.

NOTE

You can’t apply special filters if you’re using the Index print 

format.

4 When you’re done, press the W.B. button again to 

return to the previous menu.

5 When you’re ready to print your index, follow the steps 

on page 12-8.

Removing the Direct Print Program 

Direct Print comes pre-installed on your camera, but you can 

use the EPSON Program Uploader to remove it if you don’t 

plan to use it. You can always install the program later, if you 

need it. Follow these steps:

1 Connect the camera to your computer. (See Chapter 6 

for instructions.) Then turn the camera’s dial to . 

2 Start EPSON Program Uploader. Under Windows, 

click Start, then point to Programs, EPSON 

Photo!3 Ver. 1, EPSON Program Uploader. You 

see a screen similar to the following:
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3 Select Direct Print V3.0 in the Applications in 

Camera listbox.

4 Click Remove. You see a confirmation message asking 

if you’re sure you want to remove it.

5 Click Yes to remove the program, or No to cancel. 

Then click Close to exit Program Uploader.

Reinstalling the Direct Print Program 

Follow these steps to reinstall the Direct Print program to 

your camera:

1 Connect the camera to your computer and turn the 

camera’s dial to . 

2 Insert your CD-ROM in your drive. If the install 

program starts automatically, exit the program.

3 Start EPSON Program Uploader.

4 When you see the EPSON Program Uploader screen, 

click Browse to navigate to the root directory of your 

CD-ROM drive.

5 Select Direct Print V3.0 in the Applications in 

Folder listbox.

6 Click the Upload button. You see a progress meter, and 

after a moment Direct Print V3.0 appears in the 

Applications in Camera listbox.

7 Click Close to exit.

Reading Error and Status Messages

If you see an error or status message on the camera’s LCD 

screen or status display panel, check the following tables to 

respond to the message.

LCD screeen messages

Message Description

No Photos in Memory. There are no pictures in the camera’s memory. 
Press any button to return to the main menu.

Please Select at least 
one photo to print.

You haven’t selected the picture you want to 
print. Press the button next to OK (the bottom 
button), then press the button next to Photo 
Selection (the bottom button) and select a 
picture.
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Unsupported printer 
model. Please connect 
supported model.

The camera is connected to an incompatible 
printer. Connect the camera to one of the 
compatible EPSON Stylus models listed on page 
12-1. Hold down the MENU button to cancel 
printing.

Connection or printer 
error.

Printing stopped because of a printer error. Check 
your printer and clear the error (you may need to 
turn the printer and camera off and then on again), 
then restart printing from the beginning. (See your 
printer user’s guide for troubleshooting 
information.)

OK to erase printing 
settings?

You are about to erase the current print settings. 
Press the button next to YES (the bottom button) 
to erase the settings, or press the button next to 
NO (the top button) to save the settings and 
return to the previous menu.

Batteries are low. Use 
AC adapter.

Battery power is almost out. If you have the 
optional AC adapter, connect it to continue. 
Otherwise, replace the batteries with batteries 
that have been fully charged.

Error. Settings reset to 
default.

An unknown error occurred and your settings 
were returned to their defaults. Press the bottom 
button to return to the main menu and enter your 
print settings again.

Insert a Memory Card 
in the camera.

No memory card is installed in the camera, or the 
memory card is not fully inserted into its slot. 
Insert a memory card as described on page 1-10.

LCD screeen messages

Message Description

Printing canceled. You held down the MENU button to cancel 
printing. The message disappears after three 
seconds.

Printing canceled. 
Reset printer and 
camera.

A printing error occurred. The message 
disappears after three seconds. Turn off the 
camera and printer, then turn them on and try 
printing again.

Status display panel messages

Message Description

E51: Another interface 
is active

The printer is receiving a print job from another 
source (through a different interface). When that 
print job is finished, the printer begins printing 
from Direct Print automatically.

E55: No ink Printing has stopped because the printer ran out 
of ink. Replace the ink cartridges and restart 
printing from the beginning. See your printer 
User’s Guide for instructions on replacing ink 
cartridges.

E56: No paper or paper 
jam

Make sure paper is loaded in the printer, then 
press the printer’s 

 

E Load/Eject button to begin 
printing. 

If paper is jammed in the printer, follow the 
instructions in your printer User’s Guide to clear 
the jam. Then restart printing from the beginning.

LCD screeen messages

Message Description
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Maintenance and Troubleshooting

.

our PhotoPC 800 camera is easy to take care of, andYany problems you may have are easy to solve. This 

chapter includes the following sections:

◗ Caring for the camera and battery charger

◗ Solving camera problems

◗ Solving picture problems

Caring for the Camera and Battery 

Charger

Your PhotoPC 800 requires only basic care. Before you 

perform any maintenance procedures, be sure to read the 

safety instructions in the Introduction. Then observe the 

following guidelines.

13   

Cleaning the Camera and Battery Charger

◗ Unplug the battery charger before cleaning.

◗ Use a clean, dry cloth to wipe the camera free of dust.

◗ Use a damp cloth for cleaning the battery charger.

◗ Keep the battery charger terminals clean by wiping them 

with a dry cloth.

◗ Don’t use harsh or abrasive cleaners. Don’t use liquid or 

aerosol cleaners.

◗ To clean the lens, first blow off any loose dust or dirt. 

Then breathe on the lens and wipe off all moisture with 

a soft, lint-free cloth or lens cleaning tissue. To avoid 

scratching the lens, don’t press too hard.
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◗ If necessary, clean the battery contacts with a dry cloth.

◗ If the LCD screen gets fingerprints or smudges on it, use 

a soft, damp cloth to lightly wipe the screen. 

Storing the Camera

◗ When you’re not using the camera, keep the lens cover 

closed and store the camera in the soft case that came 

with it. Make sure the camera dial is set to Off.

◗ When the camera is not used for long periods of time, 

remove the batteries and store them at a low temperature 

in a dry location. This prevents camera damage from 

battery leaks or corrosion.

Do not store the camera in the following locations:

◗ Where it will be exposed to direct sunlight, for example, 

on a car dashboard

◗ Near sources of bright light or high humidity

◗ Near heat sources or in a closed car or trunk

◗ In areas of excessive dirt or dust

◗ Where it will be exposed to strong vibrations or 

magnetic fields

Solving Camera Problems

Before you call for help, check this list of problems and 

possible solutions:

The camera has no power.

◗ If you’re using batteries, the camera may have shut off 

automatically to conserve battery power. If your camera 

dial is set to , or , press the shutter button to turn 

the power back on. If your camera dial is set to  or , 

press any button on the back of the camera to turn the 

power on. (You can also turn the power on by turning 

the camera dial to Off and then back to its former 

position.)

◗ Check the batteries and make sure they’re installed 

correctly. Recharge or replace the batteries.
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◗ If you are using the AC adapter, make sure it’s plugged 

into a working outlet.

You can’t take a picture with the camera.

◗ The flash may be recharging. Wait until the status light 

turns green, and try again.

◗ Make sure you’ve installed the CompactFlash memory 

card in your camera. If it’s already installed, you may 

need to format or eject it. Check to see if a message is 

displayed on the camera’s LCD screen.

◗ The CompactFlash memory card may be full. Check the 

picture counter on the display panel. Erase some pictures 

(see Chapter 5), or transfer the pictures to your 

computer and then erase them (see Chapter 6). Or 

replace your memory card with a new one.

◗ The camera may be connected to your computer. When 

it’s connected, you can’t use any of the controls on the 

camera itself. See Chapter 10 for instructions on taking 

pictures from your computer.

◗ Make sure the lens cover is open.

The flash doesn’t work.

◗ Make sure the flash is not set to the flash off setting.

◗ Check the batteries and make sure they’re installed 

correctly. Recharge or replace the batteries if necessary.

◗ You can’t use the flash in continuous shoot mode.

Nothing appears on the LCD screen.

◗ Check your batteries and make sure they’re installed 

correctly. Recharge or replace the batteries if necessary.

◗ Make sure the lens cover is open.

◗ Make sure you’ve installed and formatted the 

CompactFlash memory card.

◗ The camera may have shut off automatically. If your 

camera dial is set to  or , press the shutter button to 

turn the power back on. If your camera dial is set to  

or , press any button on the back of the camera to 

turn power on. (You can also turn power on by turning 

the camera dial to Off and then back to its former 

position.)
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◗ Make sure the camera is not in  viewfinder mode.

The image on the screen is too dark.

◗ Adjust the brightness of the screen using the Camera 

SETUP menu. See page 4-28 for instructions.

The menus disappear while you’re taking pictures with the 

LCD screen.

◗ The menus disappear when you press the MENU 

button. Press the MENU button again to make them 

reappear.

Nothing appears on the television when you connect your 

camera to it.

◗ Make sure the video cable is connected correctly, as 

described on page 11-11, and the camera and TV are 

turned on.

◗ Make sure your camera dial is set to .

◗ If your TV has both Video and S-Video modes, make 

sure the TV is set to Video mode. See the manual for 

your television if you need help. 

◗ Check your batteries and make sure they’re installed 

correctly. Recharge or replace the batteries if necessary.

The “pictures remaining” number on the display panel 

doesn’t decrease after you take a picture.

◗ Your camera is operating correctly. The total number of 

pictures you can store depends on your pictures’ 

content. The number doesn’t always change, especially 

when you’re using standard image quality.

You get an error message when you try to transfer your 

pictures to the computer.

◗ Make sure the cable is connected correctly as described 

in Chapter 6.

◗ Make sure your camera is turned on and the batteries 

have enough power.
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◗ Check the serial port settings in your Image Expert or 

EPSON Photo!3 software. You may need to change the 

Port and Speed serial connection settings to Auto.

◗ If you’re using a Windows system and have trouble 

connecting to the COM port, check the computer’s 

COM port settings. Make sure the port is properly 

configured and that the Base I/O port address and the 

Interrupt Request Number (IRQ) assigned to the port 

are not in conflict with any other devices.

◗ Check the port setting in your Windows Control panel. 

You may need to set your port to a faster speed, lower 

the FIFO buffer size (advanced serial port 

configuration), or adjust the speed in your software. See 

“Adjusting Camera Settings From Your Computer” on 

page 10-5 for more information.

◗ If you’re using a Macintosh and the camera is sharing a 

serial port with another device, turn AppleTalk off. 

◗ If your camera is connected to a USB hub, try 

connecting the camera directly to your computer.

◗ Make sure you don’t have both Image Expert and 

EPSON Photo!3 open at the same time.

You get a “The Camera Is Not Responding” error message 

when you’re using your PhotoPC 800 software with the 

camera connected to your computer.

◗ Make sure the cable is connected correctly as described 

in Chapter 6. Also make sure your camera dial is not 

turned Off and the batteries have power.

◗ Check the serial port settings in your Image Expert or 

EPSON Photo!3 software. You may need to change the 

Port and Speed serial connection settings to Auto. 

◗ If you were able to use the camera with the computer 

previously and then changed or added other settings on 

your system, you may have a COM port conflict. Try 

using a different COM port or reconfiguring the COM 

port settings. (See your Windows documentation for 

instructions.) If you were not able to use the camera 

with your computer previously, you may have an 

inoperable serial cable. Try using another cable.

Altair.book  Page 5  Thursday, July 1, 1999  3:33 PM



13-6   Maintenance and Troubleshooting

◗ If your camera is connected to a USB hub, try 

connecting the camera directly to your computer.

◗ Avoid opening or working with other software 

applications while the camera and computer are 

communicating.

You are unable to drag and drop photos into a document.

◗ If your system has less than 32MB RAM, you may not 

be able to use drag and drop. Make sure you don’t run 

too many applications at the same time. You may need 

to add memory to your system or use another method of 

getting photos into your documents.

◗ Your application may not support this method of adding 

pictures.

You are unable to copy and paste or import your photo into 

a document on your Macintosh. 

◗ Try increasing your virtual memory using the Memory 

Control Panel. Also increase the memory allocation for 

your word processor or other application. (Select the 

application and choose Get Info from the File menu.)

◗ Try turning off any unnecessary extensions. See your 

Macintosh documentation for more information.

The pictures transfer to your computer too slowly.

◗ If your system has less than 32MB RAM, the transfer 

speed may be slow. Try using virtual memory. See your 

computer documentation or system help for more 

information.

◗ Check the port setting in your Windows Control panel. 

You may need to set your port to a faster speed. See your 

Windows documentation or help system for more 

information.

◗ If you’re transferring pictures to an application through 

EPSON Photo!3 and you use the PhotoEnhance™ 

feature, the transfer will take longer. Try transferring 

without PhotoEnhance.

You get a TWAIN error message when you try to transfer 

images with Adobe Photoshop.

◗ Make sure you select TWAIN_32, not TWAIN.

Altair.book  Page 6  Thursday, July 1, 1999  3:33 PM



Maintenance and Troubleshooting  13-7

A

B

13
You are unable to format or use a CompactFlash storage 

card with your camera.

◗ Make sure you’re using an ATA-compatible 

CompactFlash card. Other cards may not work with 

PhotoPC 800. If you need help with a card, call the 

appropriate number:

◗ Lexar Media, (800) 789-9418

◗ SanDisk, (408) 542-0595

You’ve purchased a CompactFlash card that doesn’t fit in 

the camera.

◗ Make sure you purchased the correct size CompactFlash 

card (1.7 inches wide × 1.5 inches high × 0.13 inch 

deep).

◗ Make sure you’ve installed the card correctly. The card’s 

label should be facing the front of the camera, and the 

arrow(s) on the label should point down.

Your notebook computer’s PCMCIA drive can’t access a 

CompactFlash storage card with a PCMCIA adapter.

◗ If you’re using an IBM Thinkpad,™ you may need an 

updated driver for your PCMCIA port. Call IBM 

technical support. 

When you upload pictures to a storage card in your 

computer, your system appears to hang.

◗ Check the status bar at the bottom of your screen. If it 

shows that the transfer is complete, your system is 

operating correctly. You may have to click your mouse 

to change the hourglass icon to a normal pointer.

When you copy image files from your computer to a 

storage card in your PCMCIA drive, the camera can’t 

access the images.

◗ You can’t use this method to upload pictures to the 

camera. You have to use the EPSON Photo File 

Uploader3 to convert and upload your images.
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Solving Picture Problems

If you’re not satisfied with some of the pictures you get from 

the PhotoPC 800, you may need to adjust some of the 

camera settings. Read the suggestions below.

Your pictures display poor image quality on the screen or 

when you print them out.

◗ PhotoPC 800 captures images in 24-bit color 

(16.7 million colors). Your pictures will not display 

maximum image quality if your monitor or computer’s 

video controller doesn’t support this color depth. You 

may need to upgrade your system to achieve the best 

possible image quality.

◗ If your pictures look better on the screen than when you 

print them out, you may need to upgrade your printer. 

An EPSON Stylus ink jet printer, for example, provides 

excellent image quality.

◗ If you used drag and drop to insert your pictures, they 

may appear grainy. Try importing them into your 

documents instead.

When you preview images on your computer, they look 

distorted.

◗ If you are using an STB® Velocity 128 video card and 

have a screen resolution of 800 × 600 or 640 × 480, you 

may notice this phenomenon. Slowing down the 

acceleration on your video card may solve this problem: 

Click Start, point to Settings, click Control Panel, 

then double-click System Properties. On the 

Performance tab, click the Graphics button. Select a 

slower acceleration and click OK. See your Windows 

documentation or help system for more information.

The colors in your picture don’t look right.

◗ When you take pictures under certain artificial lighting 

conditions, the colors may be slightly distorted. You can 

use your Image Expert software to adjust the colors, as 

described on page 9-3.

Altair.book  Page 8  Thursday, July 1, 1999  3:33 PM



Maintenance and Troubleshooting  13-9

A

B

13
Your picture is blurry or out of focus.

◗ Make sure your subject is within the camera’s range. You 

should be at least 20 inches away to take a picture 

without the flash, and 20 inches to 8 feet away to take a 

picture with the flash. You can take a picture from as 

close as 8 inches in macro mode.

◗ When you take macro close-ups, make sure you have 

adequate lighting (with the flash disabled). Using a 

tripod will help you capture sharp pictures.

◗ Make sure that your subject isn’t moving and that you 

hold the camera steady after you press the shutter button 

(until the camera status light or photo capture light 

starts flashing).

◗ If you want to photograph a moving subject, try 

increasing the shutter speed. See Chapter 4 for 

information about how to change the shutter speed from 

the LCD menus.

◗ Make sure your flash is not set to flash off.

◗ When you focus on a nearby object, your picture’s 

background may appear blurry. Try changing your 

focus.

Your picture is too dark (underexposed).

◗ You may need to use the flash. Make sure the setting is 

not flash off.

◗ If you’re using the flash, make sure your subject is within 

the range of 8 feet. 

◗ Use Image Expert to adjust the picture’s brightness and 

contrast, as described on page 9-4.

◗ Try adjusting the camera’s exposure or sensitivity 

settings (Use the Manual user mode). See Chapter 4 for 

details.

◗ If you’re using the macro mode to take a close-up photo, 

be sure to provide adequate lighting for your subject, 

since the camera’s smallest aperture setting (F8) is 

automatically selected in this mode.
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◗ If you’re taking a picture at night and you want to light 

up the background as well as your subject, use the 

camera’s slow synchronized flash mode.

Your picture is too light (overexposed).

◗ If you’re using the forced flash setting, it may be too 

bright. Try setting the flash to Auto .

◗ If you’re facing a bright light source, you may need to 

shoot your picture from a different angle.

◗ Use Image Expert to adjust the picture’s brightness, as 

described on page 9-4.

◗ Set user mode to Manual and adjust the camera’s 

exposure setting.

Part of your picture is missing.

◗ Make sure you’re not blocking the lens with your finger, 

wrist strap, clothing, or other object.

A horizontal or vertical red line appears on your picture.

◗ Red lines are caused by glare. Avoid photographing 

shiny surfaces that reflect excessive amounts of light into 

your lens. 

The wrong date and/or time are displayed on your pictures.

◗ Whenever you change the batteries in your camera, you 

need to reset the clock. You can use the LCD screen 

SETUP menu or set the camera’s clock from your 

computer. See Chapter 4 or Chapter 10 for more 

information.

Your pictures don’t look as good as they used to.

◗ Your camera’s lens may be dirty or dusty. Try cleaning it 

by following the instructions on page 13-1.
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The area captured in the photo is different from what you 

saw in the viewfinder.

◗ Make sure you look straight through the viewfinder. 

Keep in mind that the area visible through the 

viewfinder is slightly smaller than the area captured in 

the photo.

◗ If you’re taking a close-up or macro mode picture, turn 

the camera dial to  so that you can use your LCD 

screen to preview your picture.
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ou can use the PhotoPC 800 with a variety of options.YTo save battery power, you can use the AC adapter. 

For portraits or other studio photographs, you can attach a 

tripod to your camera. You can also get additional 

CompactFlash memory cards, or a second set of NiMH 

batteries and a replacement NiMH Power Pak.

You can use an optional IOMEGA Clik! drive to store 

photos and transfer them to your computer. Or, if your 

desktop or notebook computer has a Type II PCMCIA card 

slot, you can use a PCMCIA adapter to access images directly 

from your memory card.

A   

Finally, if you want to verify the authenticity of photos taken 

with your camera, you can purchase the EPSON Image 

Authentication System (IAS). This software detects when 

even a single bit of digital data in a picture has been altered.

EPSON recommends CompactFlash memory cards from the 

following manufacturers:

◗ Lexar Media, (800) 789-9418

◗ SanDisk, (408) 542-0595

Make sure you purchase the correct size card (1.7 inches 

wide × 1.5 inches high × 0.13 inch deep). The PhotoPC 800 

will accept ATA-compatible Type 1 CompactFlash cards up 

to 96MB.

Optional Accessories
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For information on installing, formatting, and removing 

memory cards from your camera, see Chapter 1.

This chapter includes the following information:

◗ Using the universal AC adapter

◗ Using the camera with a tripod

◗ Using a PCMCIA adapter

◗ About the IOMEGA Clik! drive 

The options listed above should be available where you 

bought your PhotoPC 800. 

You can order any of the following accessories from EPSON 

Accessories at (800) 873-7766 (U.S.) or (800) 873-7766 

(in Canada for dealer referral).

Using the Universal AC Adapter

The universal AC adapter (B867062) allows you to connect 

your PhotoPC 800 to any standard (100 to 240 V) electrical 

outlet. This is especially useful for transferring pictures and 

operating the camera from your computer, or using Direct 

Print. The adapter powers the camera but does not charge 

the batteries.

WARNING

◗ Use only the adapter designed for the PhotoPC 800. Using 

any other adapter may cause fire, electrical shock, or injury.

◗ Do not alter the plug on the power cable, and do not use the 

adapter for any other purpose than powering your

PhotoPC 800.

Accessory Product code

PhotoPC 800 Universal AC Adapter B867062

NiMH Battery Pak (4 batteries) B818061

Universal NiMH Power Pak (charger and 4 batteries) B818172

EPSON Image Authentication System (IAS) PPC8-IAS
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To avoid losing any images or settings, make sure the camera 

is finished processing. Turn the camera off before you 

connect or disconnect the AC adapter. Then follow these 

steps:

1 Locate the AC power cord that came with your camera. 

Push the adapter’s cable connector firmly into the AC 

inlet.

2 Open the connector cover on the side of the camera.

3 Plug the adapter cable into the DC port on the camera.

4 Plug the AC power cord into an electrical outlet.
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Using an Optional Tripod

You can use your PhotoPC 800 with any standard tripod. 

Follow these steps:

1 Assemble and set up the tripod by following the 

manufacturer’s instructions. Make sure the tripod is 

well-balanced on a flat surface.

2 Find the opening for the tripod screw on the bottom of 

your camera. Carefully place the camera on the tripod. 

Screw the camera on until it is firmly in place.

3 Adjust the tripod to view your subject as desired.

Using a PCMCIA Adapter

A PCMCIA adapter allows you to access images stored on 

CompactFlash cards directly from your computer. To use 

this adapter, your computer must be equipped with a Type II 

PCMCIA card slot.

If you’re using a Macintosh, you must enable PC Exchange 

extension software to access files on CompactFlash cards. See 

your Macintosh documentation for information.

Installing the PCMCIA Adapter

Follow these steps to install the adapter:

1 Insert the memory card all the way into the adapter.
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2 Insert the adapter into your computer’s Type II 

PCMCIA slot.

Transferring Photos With the Adapter

Once the adapter and card are installed in your computer’s 

PCMCIA slot, you can transfer photos by simply copying 

them to your hard drive. This is the fastest way to get 

pictures into your computer. The image files are stored in the 

Photo_1 folder on the card.

◗ In Windows, use My Computer or the Windows 

Explorer to drag and drop image files to your hard drive.

◗ On a Macintosh, use the Finder to drag and drop image 

files to your desktop or hard drive.

NOTE

◗ If you don’t have an adapter, you can use Image Expert to 

transfer photos to your computer. See Chapter 6.

◗ If you can’t access a card in your notebook computer, 

contact the computer manufacturer. See page 13-7 for more 

information.
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About the IOMEGA Clik! Drive

You can use an IOMEGA Clik! digital camera drive to store 

extra pictures when you’re on the go and read CompactFlash 

cards directly from your computer. This drive saves time and 

batteries because you don’t have to download pictures from 

your camera to your computer. You should be able to find 

the IOMEGA Clik! drive where you purchased your camera. 

For additional information, visit the IOMEGA website at: 

www.iomega.com. You can call IOMEGA at 

(800) MYSTUFF ( [800] 697-8833) for ordering 

information.
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Camera

Physical Dimensions
Width 4.4 in (111.4 mm)

Height 2.7 in (68 mm)

Depth 1.6 in (40.2 mm)

Weight 8.3 oz (235 g) 
without batteries and strap

B   

Power
Sources Includes 4 AA rechargeable NiMH 

batteries and pocket-size charger. Also 
accepts 2 AA batteries (single-use 
lithium or rechargeable NiCad)

Optional AC adapter (B867062)

Battery Life Approximately 850 pictures using the 
viewfinder
Approximately 100 pictures using the 
LCD screens
Approximately 45 minutes in playback 
mode

Specifications
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Technical
Product type 2.14 megapixel CCD (charged coupled 

device) still frame auto focus camera

CCD 0.5 inch color area CCD (2.14 million 
pixels)

Image resolution 1600 × 1200 pixels (fine and super fine)
640 × 480 pixels (standard)
1600 × 600 pixels (panoramic fine)
1600 × 600 pixels (panoramic super fine)
1984 × 1488 pixels* (HyPict)
1984 × 744 pixels* (HyPict panorama)
     * Interpolated

File format JPEG 

Bit depth 16 million colors, 24-bit

Serial 
communication 
speed

Up to 230.4 Kbps with high-speed serial 
port (19.2 Kbps or higher), 1.8 Mbps 
when connected to EPSON printers

Serial interface 14-pin dual line terminal to camera, 
RS-232C-compatible connector to 
computer (9-pin DSUB connector to PC, 
8-pin mini-DIN male connector to 
Macintosh or printer)

USB cable 14-pin connector (camera)
USB connector (computer)

USB 
communication 
speed

Up to 12 Mbps

Video out NTSC standard

Internal memory 2MB flash program memory

Expansion memory 8MB CompactFlash storage card;
also accepts optional 4MB to 96MB 
storage cards (available from Lexar Media 
and SanDisk)

Self-timer 10 seconds

Tripod adapter Built-in
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Environmental

Safety

Photographic
Temperature Operating:  41 to 95 °F (5 to 35 °C)

Non-operating: –4 to 140 °F (–20 to 
60 °C)

Humidity Operating: 30 to 80% (non-condensing)
Non-operating: 10 to 80% (non-
condensing)

United States FCC Part 15 Subpart B Class B

Canada CSA C108.8 Class B

Lens f = 7 mm (equivalent to a 38 mm lens on 
a 35 mm camera)

Range 19.7 inches (50 cm) to infinity;
5.9 to 19.7 inches (15 to 50 cm) in macro 
mode

LCD screen 1.8-inch active matrix TFT color LCD 
(110 thousand pixels)

Sensitivity Equivalent to ISO 100/200/400

Exposure control Programmed auto exposure
manual adjustment: –2 to +2 EV, in half-
steps (or in 0.2 EV steps in AE mode);
spot metering and matrix metering

White balance TTL automatic white balance
Fixed white balance (5200 °Kelvin)
User-defined white balance
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Flash range:

Memory Card Picture Capacity

Shutter Electric iris with mechanical shutter, 
1/2 second to 1/750 second (flash off 
mode)
1/30 second to 1/750 second (auto flash 
and forced flash modes)

Viewfinder Real-image optical, with centering 
crosshair and edge border (view range 
approximately 90%)

Focus Automatic focus from 19.7 inches 
(50 cm) to infinity 
Automatic focus from 5.9 to 19.7 inches 
(15 to 50 cm) in macro mode

Aperture f2.4, f8.0

Flash Automatic luminance control flash mode

Flash modes Forced flash, automatic, flash off,
slow synchronized flash mode (can be 
enabled through the LCD menus)

Sensitivity setting Normal distance 2× zoom

Std. (ISO 100) 1.6 to 11.2 ft (0.5 to 
3.4 m)

1.6 to 11.2 ft (0.5 to 
3.4 m)

Med. (ISO 200) 1.6 to 16.1 ft (0.5 to 
4.9 m)

1.6 to 16.1 ft (0.5 to 
4.9 m)

High (ISO 400) 1.6 to 22.6 ft (0.5 to 
6.9 m)

1.6 to 22.6 ft (0.5 to 
6.9 m)

Image Mode 8MB Card

Standard 118

Fine/Monochrome Fine 25

SuperFine/Monochrome 
SuperFine

12

HyPict/Monochrome HyPict 10
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B

B

NiMH Battery Charger

Physical Dimensions

Technical

Optional AC Adapter

Physical Dimensions

Technical

CompactFlash Card

Physical Dimensions

Width 3.0 inches (76 mm)

Height 4.5 inches (115 mm) 

Depth 1.1 inch (28 mm)

Weight Approximately 4.6 oz (130 g)

Input 100 to 240 V, 50 to 60 Hz

Output DC 1.2 V/490 mA × 4

Charging time 2 batteries: approximately 110 minutes
4 batteries: approximately 210 minutes

Power consumption Approximately 8W

Charging 
temperature

41 to 95 °F (5 to 35 °C)

Storage temperature −4 to 86 °F (−20 to 30 °C)

Width 1.7 inches (43 mm)

Height 1.22 inches (31 mm) 

Depth 4.1 inches (104 mm)

Output DC 3.5 V/2.5 A

Input 100 to 240 V AC, 50 to 60 Hz

Width 1.7 inches (42.8 mm)

Height 1.5 inches (36.8 mm)

Depth 0.13 inch (3.3 mm)
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A

B

A

AC adapter, Intro-4, 2-3, 6-1, A-2 to A-3, B-5
Accessories, Intro-4, A-1 to A-6
Acquiring photos, TWAIN programs, 6-10 to 6-11
Adjusting camera settings, 3-1 to 3-8, 4-1 to 4-30
Albums

adding sound to images, 8-8 to 8-9
copying to diskette, 8-13 to 8-14
deleting sounds, 8-10 to 8-11
displaying as slide show, 8-11 to 8-12
dragging pictures from, 7-4 to 7-6
editing sound in pictures, 8-10
making screen saver, 8-12
organizing pictures, 8-2 to 8-3
playing back sounds, 8-9
printing from camera, 12-11 to 12-12
printing Image Expert albums, 8-4 to 8-8
renaming pictures, 8-3
setting pictures as wallpaper, 8-12 to 8-13

Alert beep, setting, 4-28 to 4-29
Aperture, setting, 4-24
AppleTalk, 6-4
Attaching wrist strap, 1-9
Audio

adding, 4-13 to 4-15, 8-8 to 8-9
deleting, 5-10 to 5-11, 8-10 to 8-11
editing, 8-10
playing back, 8-9 to 8-10

Automatic power off, setting, 4-26 to 4-27

B

Batteries
charging, 1-4 to 1-6
checking, 2-2 to 2-3
handling, 1-8 to 1-9
installing, 1-6 to 1-7
options, 1-8 to 1-9
replacing, Intro-4
specifications, B-1

Index
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Battery charger, specifications, B-5
Bitmap (BMP) files, 6-13
Black and white pictures, taking, 4-4
Brightness

correcting images, 9-3 to 9-4
setting LCD brightness, 4-28

Buttons, adjusting settings with, 3-1 to 3-8

C

Cable
DirectPrint, connecting, 12-2 to 12-3
Macintosh serial, connecting, 6-4 to 6-5
USB, connecting, 6-2
video, connecting, 5-17 to 5-19, 11-11 to 11-12
Windows serial, connecting, 6-3 to 6-4

Camera
dial settings, 2-1 to 2-2
features, Intro-1 to Intro-3
identifying parts, 1-2 to 1-3

Camio Viewer, 7-6 to 7-8
Caring for camera, 13-1 to 13-2
Charging batteries, 1-4 to 1-6
Cleaning camera, 13-1 to 13-2
Clock, setting, 1-11 to 1-12, 4-29 to 4-30
Close-ups, taking, 4-7 to 4-8

Color correcting, 9-3 to 9-4
Color depth, 9-9
CompactFlash storage cards, see Memory card
CompuServe, Intro-6
Computer, connecting camera, 6-1 to 6-5
Connecting

AC power cord, A-3
Direct Print cable, 12-2 to 12-3
serial cable, 6-3 to 6-5
USB cable, 6-2
video cable, 5-17 to 5-19

Continuous shooting, 4-10 to 4-13
using interval shooting, 4-12 to 4-13
using the timer, 4-11 to 4-12

Contrast, correcting, 9-3 to 9-4
Copying pictures

into documents, 7-3 to 7-4
to diskette, 8-13 to 8-14

Cropping images, 9-5

D

Date and time, setting, 1-11 to 1-12, 4-29 to 4-30
Deleting pictures, see Erasing pictures from camera
Digital zoom, using, 4-5 to 4-6
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B

Direct Print
connecting the cable, 12-2 to 12-3
error messages, 12-17 to 12-18
index, printing, 12-15 to 12-16
multiple images, printing, 12-4 to 12-9
photo stickers, printing, 12-13 to 12-14
print formats, 12-4
reinstalling, 12-17
removing from camera, 12-16 to 12-17
single images, printing, 12-4 to 12-9
starting, 12-3

Diskettes, copying pictures, 8-13 to 8-14
Display panel

messages, 12-17 to 12-18
reading, 2-2 to 2-4

Distorting images, 9-7 to 9-9
Documents, getting pictures into, 7-1 to 7-8, 13-6
Downloading pictures, 6-1 to 6-14, 7-6 to 7-8
Drag and drop, 7-4 to 7-6, 7-7 to 7-8

E

Edges, sharpening, 9-8
Editing

applying Quick Fix to images, 9-3
images, 9-2 to 9-9
sounds, 8-10

E-mail, sending pictures, 8-14 to 8-16
Environmental specifications, B-3
EPSON

Electronic support services, Intro-6 to Intro-7
help, Intro-6 to Intro-7
registration, Intro-7
World Wide Web site, Intro-6

EPSON Photo File Uploader, 11-1 to 11-12
EPSON Photo!3

importing images, 6-10 to 6-14
problems, 6-14 to 6-15
support, Intro-7
using, 6-12 to 6-15

Equalization, 9-4
Erasing pictures from camera

using computer, 6-8, 6-11, 6-13, 7-7
using LCD screen, 5-4 to 5-6

Error messages
on camera display panel, 12-17 to 12-18
on computer, 6-9 to 6-10, 6-14, 13-4

Exporting images, 6-12 to 6-13
Exposure

adjusting, 3-7 to 3-8, 4-24
predefined settings, 4-22 to 4-23
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F

FaxAdvice service, Intro-6
Features, camera, Intro-1 to Intro-3
Files

BMP, 6-13
converting during transfer, 6-12 to 6-14
JPEG, 6-12 to 6-13, 7-2
PCX, 6-13
PICT, 6-13
resizing, 9-5 to 9-6
uploading, 11-1 to 11-7
viewing information, 8-3 to 8-4

Fisheye effect, 9-8
Flash

problems, 13-3
range, B-4
using, 3-3 to 3-4

Flipping images, 9-7
Focus, adjusting, 4-24 to 4-25
Formatting the memory card, 1-12 to 1-13
FTP, Intro-6
Full Auto mode, description, 4-3

G

Glass blocks effect, 9-8

H

Handling batteries, 1-8 to 1-9
Help, EPSON, Intro-6 to Intro-7
HyPict image quality, 3-2

I

Image Authentication System, Intro-4
Image Expert

albums, 7-4 to 7-6, 8-2 to 8-14
audio tools, 8-9
camera settings, changing, 10-5 to 10-7
Camio Viewer, 7-6 to 7-8
color correcting, 9-3 to 9-4
color depth, changing, 9-9
copying pictures to diskette, 8-13 to 8-14
correcting images, 9-3 to 9-4
cropping, 9-5
editing pictures, 9-1 to 9-9
e-mailing pictures, 8-14 to 8-16
error messages, 6-9 to 6-10
flipping images, 9-7
picture information, 8-3 to 8-4
printing, 8-4 to 8-8
Quick Fix, 9-3
resizing images, 9-5 to 9-6
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Image Expert (Continued)
resolution, changing, 9-5 to 9-6
rotating, 9-6 to 9-7
screen saver, 8-12
selection tools, 9-2
slide shows, 8-11 to 8-12
sound, adding, 8-8 to 8-9
sound, deleting, 8-10 to 8-11
sound, editing, 8-10
special effects, 9-7 to 9-9
taking pictures from computer, 10-1 to 10-3
transferring pictures, 6-5 to 6-10, 7-6 to 7-8
wallpaper, 8-12
zoom tool, 9-2

Image quality, setting, 3-1 to 3-2, B-2
Images, see Pictures
Importing photos, TWAIN programs, 6-10 to 6-11
Index, printing, 12-15 to 12-16
Installing

batteries, 1-6 to 1-7
Direct Print in camera, 12-17
memory card, 1-10 to 1-11
PCMCIA adapter, A-4 to A-5
software, 1-14 to 1-16

Internet, Intro-6
Interval shooting, 4-12 to 4-13

Inverting images, 9-7
IOMEGA Clik! drive, A-6

J

JPEG files, 6-12 to 6-13, 7-2

L

Landscape subject setting, 4-15
Language, setting, 4-30
LCD screen

erasing pictures, 5-4 to 5-6
magnifying pictures, 5-11 to 5-12
playing back pictures, 5-1 to 5-19
problems, 13-3 to 13-4
setting brightness, 4-28
specifications, B-3

Licensing software, Intro-7
Live preview, 10-1 to 10-5

M

Macintosh
capturing screens, 11-9 to 11-10
connecting to camera, 6-1 to 6-5
installing software, 1-16
system requirements, Intro-5
uploading pictures, 11-5 to 11-9
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Macro mode, using, 4-7 to 4-8
Magnifying pictures, 5-11 to 5-12
Maintenance, 13-1 to 13-2
Manual mode, description, 4-3
Memory card

capacity, B-4
dimensions, B-5
formatting, 1-12 to 1-13, 13-7
installing, 1-10 to 1-11
removing, 1-13
uploading images to, 11-1 to 11-7

Metering method, changing, 4-25 to 4-26
Monochrome pictures, taking, 4-4

N

Negative images, 9-8
NiMH Power Pak, ordering, Intro-4

O

Options
AC adapter, specifications, B-5
AC adapter, using, A-2 to A-3
IOMEGA Clik! drive, A-6
ordering, A-2
PCMCIA adapter, using, A-4 to A-5
tripod, using, A-4

P

Panoramic pictures, 4-8 to 4-9
PCMCIA adapter, using, A-4 to A-5
PCX files, 6-13
Photo File Uploader, 11-1 to 11-12
Photo stickers, printing, 12-13 to 12-14
Photographic specifications, B-3
Photos, see Pictures
Physical dimensions, B-1
PICT files, 6-13
Picture counter, checking, 2-3 to 2-4
Pictures

black and white, 4-4
capturing from computer, 10-1 to 10-5
close-ups, 4-7 to 4-8
color correcting, 9-3 to 9-4
color depth, changing, 9-9
converting, 7-2
copying to diskette, 8-13 to 8-14
correcting, 9-2 to 9-4
cropping, 9-5
e-mailing, 8-14 to 8-16
erasing with camera, 5-4 to 5-6
erasing with computer, 6-8, 6-11, 6-13, 7-7
exporting, 6-12 to 6-13
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Pictures (Continued)
flipping, 9-7
macro mode, 4-7 to 4-8
magnifying, 5-11 to 5-12
organizing in albums, 8-2 to 8-3
panoramic, 4-8 to 4-9
playing back on TV, 5-17 to 5-19
printing from camera, 12-4 to 12-16
printing from computer, 8-4 to 8-8
problems, solving, 13-8 to 13-11
quick shots, 4-4 to 4-5
resizing, 9-5 to 9-6
rotating, 9-6 to 9-7
screen saver, 8-12
selecting sections, 9-2 to 9-4
slide shows, 5-13 to 5-16, 8-11 to 8-12
special effects, 9-8 to 9-9
transferring from camera, 6-1 to 6-14, 7-6 to 7-8
uploading, 11-1 to 11-7
using digital zoom, 4-5 to 4-6
viewing information, 8-3 to 8-4
wallpaper, 8-12

Playing back pictures, 5-1 to 5-19
Portrait subject setting, 4-15

Power
AC adapter, 2-3, A-2 to A-3, B-5
battery, see Batteries
camera specifications, B-1
problems, 13-2

Power off interval, setting, 4-26 to 4-27
Power Pak, ordering, Intro-4
Presentations, using camera for, 11-1 to 11-12
Printing photos from camera

album format, 12-11 to 12-12
cards, 12-10 to 12-11
index of images, 12-15 to 12-16
photo stickers, 12-13 to 12-14
print formats, 12-4
single images, 12-4 to 12-9

Printing photos from computer
adding text, 8-6
adjusting printed area, 8-7 to 8-8
choosing album images, 8-7
layout styles, 8-4 to 8-6

Altair.book  Page 7  Thursday, July 1, 1999  3:33 PM



8   Index

Problems
camera, 6-14 to 6-15, 13-2 to 13-7
Direct Print, 12-17 to 12-18
EPSON Photo!3, 6-14 to 6-15
flash, 13-3
LCD screen, 13-3 to 13-4
memory card, 13-7
picture, 13-8 to 13-11

Program mode
description, 4-3
using programmed subject settings, 4-15 to 4-16

Projector, playing back pictures and presentations, 
11-11 to 11-12

Q

Quick Fix, 9-3
Quick shots, taking, 4-4 to 4-5

R

RAM, system requirements, Intro-4 to Intro-5
Registration, Intro-7
Removing Direct Print from camera, 12-16 to 12-17
Resizing files, 9-5 to 9-6
Resolution, 3-1 to 3-2, 9-5 to 9-6, B-2
Ripples effect, 9-8
Rotating pictures, 9-6 to 9-7

S

Safety instructions, Intro-8 to Intro-9
Save to Floppy option, 8-13 to 8-14
Screen captures, 11-8 to 11-10
Self timer, using, 3-4 to 3-5, 10-3 to 10-5
Sending pictures by e-mail, 8-14 to 8-16
Sensitivity, adjusting, 3-5 to 3-6, 4-17 to 4-18
Serial cable, connecting, 6-3 to 6-5
Settings

adjusting, 3-1 to 3-8, 4-1 to 4-30
alert beep, 4-28 to 4-29
automatic power off, 4-26 to 4-27
color/black and white, 4-4
date and time, 1-11 to 1-12, 4-29 to 4-30
exposure, 3-7 to 3-8, 4-24
focus, 4-24 to 4-25
image quality, 3-1 to 3-2, B-2
language, 4-30
LCD brightness, 4-28
macro mode, 4-7 to 4-8
metering method, 4-25 to 4-26
panoramic pictures, 4-8 to 4-9
predefined exposure adjustments, 4-22 to 4-23
programmed subject settings, 4-15 to 4-16
sensitivity, 3-5 to 3-6, 4-17 to 4-18
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Settings (Continued)
shutter speed and aperture, 4-24
time and date, 1-11 to 1-12, 4-29 to 4-30
user mode, 4-2 to 4-3
white balance, 3-6 to 3-7, 4-18 to 4-22

Sharpness, adjusting, 9-4
Shutter

adjusting speed, 4-24
predefined exposure adjustments, 4-22 to 4-23
snapping, 2-4 to 2-6

Slide shows
excluding pictures, 5-14 to 5-15
playing pictures, 5-13 to 5-16, 8-11 to 8-12
rotating pictures, 5-15 to 5-16

Slow synchronized flash, 3-3
Software

included on CD-ROM, Intro-3
installing, 1-14 to 1-16
licensing, Intro-7
support, Intro-7

Sound
adding, 4-13 to 4-15, 8-8 to 8-9
deleting, 5-10 to 5-11, 8-10 to 8-11
editing, 8-10
playing back, 8-9
recording, 8-8 to 8-9

SoundAdvice, Intro-6
Special effects, 9-8 to 9-9
Specifications

AC adapter, B-5
battery charger, B-5
environmental, B-3
memory card, B-4, B-5
photographic, B-3
physical dimensions, B-1
power, B-1
safety, B-3
technical, B-2

Sports subject setting, 4-15
Status display panel

messages, 12-17 to 12-18
reading, 2-2 to 2-4

Stickers, printing, 12-13 to 12-14
Storage cards, see Memory cards
Storing camera, 13-2
Strap, attaching, 1-9
Support

EPSON, Intro-6 to Intro-7
software, Intro-7

System requirements
Macintosh, Intro-5
Windows, Intro-4
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T

Taking pictures
using the flash, 3-3 to 3-4
with the LCD screen, 2-6 to 2-9
with the timer, 3-4 to 3-5
with the viewfinder, 2-4 to 2-6

Technical support, Intro-6 to Intro-7
Time and date, setting, 1-11 to 1-12, 4-29 to 4-30
Timer, using, 3-4 to 3-5, 4-11 to 4-12, 10-3 to 10-5
Tripod, attaching, A-4
Troubleshooting, 13-2 to 13-11
TWAIN programs, acquiring photos, 6-10 to 6-11

U

Unpacking the camera, 1-1
Uploading pictures, 11-1 to 11-7
USB cable, connecting, 6-2
User mode, setting, 4-2 to 4-3

V

VCR, playing back pictures, 5-17 to 5-19
Video cable, 11-11
Videotaping pictures, 5-17 to 5-19

Voice recordings
adding, 4-13 to 4-15, 8-8 to 8-9
deleting, 5-10 to 5-11, 8-10 to 8-11
editing, 8-10
playing back, 8-9 to 8-10

W

Wallpaper, setting pictures as, 8-12 to 8-13
White balance

adjusting, 3-6 to 3-7, 4-18 to 4-22
fixed, 4-19 to 4-20
user-defined setting, 4-21 to 4-22

Windows
capturing screens, 11-8 to 11-9
connecting with serial cable, 6-3 to 6-4
connecting with USB cable, 6-2
installing software, 1-14 to 1-16
system requirements, Intro-4
uploading pictures, 11-2 to 11-4

World Wide Web, Intro-6
Wrist strap, attaching, 1-9

Z

Zoom tool, Image Expert, 9-2
Zoom, using digital zoom, 4-5 to 4-6
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